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1  Introduction 1 

1.1  Purpose 2 

This guide describes how to use the component applications of the Qualcomm Product Support 
Tool (QPST™) software. 

3 

4 

6 

7 

8 

9 

10 

11 

12 

14 

15 

16 

17 

18 

19 

20 

21 

1.2  Scope 5 

This user guide is written for technicians, administrators, and other personnel who operate QPST. 
It assumes that you are familiar with: 

 Basic CDMA technology 

 Microsoft Windows NT 4.0, Windows 2000, or Windows XP 

If you are installing QPST on Windows NT 4.0, Windows 2000, or Windows XP, you must have 
Administrator access to the workstation on which QPST is to be installed; contact your own 
computer support organization if you need this type of access granted. 

1.3  Conventions 13 

Button names appear in a bold font, e.g., Click Browse. 

Function declarations, function names, type declarations, and code samples appear in a different 
font, e.g., #include. 

Code variables appear in angle brackets, e.g., <number>. 

Commands and command variables appear in a different font, e.g., copy a:*.* b:. 

Parameter types are indicated by arrows: 
→ Designates an input parameter 

← Designates an output parameter 

↔ Designates a parameter used for both input and output 

 

Shading indicates content that has been added or changed in this revision of the document. 
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2 

3 

4 

5 

1.4  References 1 

Reference documents, which may include QUALCOMM®, standards, and resource documents, 
are listed in Table 1-1. Reference documents that are no longer applicable are deleted from this 
table; therefore, reference numbers may not be sequential. 

Table 1-1  Reference documents and standards 

Ref. Document 

Qualcomm 

Q1 Application Note: Software Glossary for Customers  CL93-V3077-1 

Q2 Application Note: Factory Test Mode Logging API 80-V9147-1 

Q3 QCT Tools File System Interface Control Document 80-B5750-1 

Resources 

R1 Factory Test Mode CDMA 1x RF Commands Document — 

R2 Bluetooth VI.I Specifications Book — 

1.5  Technical assistance 6 

For assistance or clarification on information in this guide, submit a case to Qualcomm CDMA 
Technologies at 

7 

8 

9 

10 

12 

13 

https://support.cdmatech.com/.  

If you do not have access to the CDMATech Support Service website, register for access or send 
email to support.cdmatech@qualcomm.com. 

1.6  Acronyms 11 

For definitions of terms and abbreviations, see [Q1]. 

 

https://support.cdmatech.com/
mailto:support.cdmatech@qualcomm.com
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2  Getting Started 1 

This chapter provides information needed to install and run the QPST™ applications, including 
the operating system and hardware requirements. It also provides support for installing the phone 
hardware and security adapter used by QPST. 

2 

3 

4 

6 

7 

8 

9 

10 

11 

12 

13 

14 

15 

16 

17 

18 

19 

2.1  What is QPST? 5 

QPST is a set of Windows tools designed to interface with, control, and test CDMA phones that 
contain Qualcomm ASICs. The QPST server can keep track of multiple phones on local host 
machines. 

QPST currently consists of the server application, which has no interface, and five component, or 
“client,” applications. Two standalone utilities, QCNView and Roaming List Editor, complete the 
QPST tool set. 

The client applications include: 

 QPST Configuration 

 Service Programming 

 Software Download 

 RF NV Item Manager 

 EFS Explorer 

Table 2-1 describes the functions provided by each QPST client. 

Table 2-1  QPST client applications 

Client Functions 

QPST Configuration  Provides basic phone status display (MIN, ESN, model) 
 Allows phone control and monitoring 

Service 
Programming 

 Saves service programming data to file 
 Allows the download of the same service programming file to multiple phones 
 Allows dialing plan, carrier information, and roaming list download 

Software Download  Downloads software to Qualcomm phones 
 Backs up and restores nonvolatile (NV) memory contents between downloads 

RF NV Item Manager  Accesses a SURF™ phone’s NV items that control RF usage 
EFS Explorer  Allows navigation of the embedded file system (EFS) of phones that support it 

 Provides file-management capabilities 
 20 
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Table 2-2 describes the functions provided by the standalone utilities. 1 

2 Table 2-2  QPST standalone utilities 

Utility name Function 

QCNView Formats QCN files created by the various clients 
Roaming List Editor Edits a phone’s roaming protocol information 

2.2  System requirements 3 

Hardware and operating system requirements for QPST are outlined in the following sections. 4 

6 

7 

8 

9 

2.2.1  Hardware 5 

Table 2-3 describes the hardware items required to operate QPST. These items represent the 
minimum requirements for normal operation. If your hardware meets or exceeds these 
requirements, then no upgrade is necessary to use QPST. 

Table 2-3  QPST hardware requirements 

Item Description 

Computer Desktop or laptop computer, 166 MHz Pentium with Layer 2 cache or better 
RAM 32 MB or greater 
Hard drive Application requires 20 MB of available space 
CD-ROM drive For installing QPST 
Video monitor Minimum display resolution of 800x600 
Serial 
communications 

Free serial I/O (COM) ports for up to eight QPST-to-phone connections 

Qualcomm SURF or 
FFA phones 

Mobiles based on the MSM3100™, MSM3300™, MSM5000™, MSM5100™, 
MSM5105™, MSM5500®, MSM6000™, MSM6025™, MSM6050™, 
MSM6100™, MSM6200™, MSM6250®, MSM6300®, or MSM6500® device 

Data cables Appropriate data cables for attaching each model of phone used with QPST to 
the computer’s serial (COM) port 

2.2.2  Operating system 10 

The computer must be running Windows XP or Windows 7. It is advisable to run only those 
device drivers normally used by the operating system or mentioned in this guide. Otherwise, you 
may experience operating anomalies, conflicts, or random failures while using QPST. 

11 

12 

13 

15 

16 

17 

18 

19 

2.3  Setting up QPST 14 

QPST installation occurs in the following stages: 

1. Setting up a laptop or desktop computer 

2. Connecting phones to the computer 

3. Installing the QPST software 

4. Initial startup 
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This section contains the information needed for setting up and configuring QPST. For 
information about your computer or mobile phone, refer to the user guide provided for that 
product. 

1 

2 

3 

4 

5 

7 

8 

9 

10 

11 

12 

13 

14 

15 

17 

18 

19 

20 

21 

22 

For more information or assistance during system setup, contact Qualcomm Technical Support at 
support.cdmatech@qualcomm.com. 

2.3.1  Setting up the computer 6 

Before installing QPST, you must first set up the computer: 

 Make sure the desktop or laptop computer is ready to power up and has Windows XP or 
Windows 7 operating system. 

 Windows XP or Windows 7 users must have Administrator privileges for the system. After 
QPST is installed, you can run it from any Windows XP or Windows 7 user account. 

 At least one available serial I/O port (COM 1 to 9) is required for connecting the test phone to 
the computer. 

 The computer hard disk must have 20 MB of free space to store and run QPST. Additional 
space is recommended for storing backup and download files. 

2.3.2  Connecting phones 16 

The following sections describe how to connect a Qualcomm phone to the QPST computer. You 
may need a 9-pin-to-25-pin adapter to connect the serial computer of the data cable to a 25-pin 
port. QPST can monitor up to eight serial ports and attached SURF phones. 

Phones may be connected anytime QPST is running; the server and its components will recognize 
their presence. 

mailto:support.cdmatech@qualcomm.com
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2.3.2.1  Connecting SURF phones 1 

Figure 2-1 illustrates how to connect SURF phones. 2 

Connects to
Back of PC

J48 J145

DP1000

CDC1000

MEM1000

MB1000

UI1000

 3 

4 

5 

6 

7 

8 

10 

11 

12 

Figure 2-1  Connecting SURF phones 

1. Plug the female end of the included serial cable into the 16550 Serial I/O card or the serial 
port connector of the PC. 

2. Plug the male end of the included serial cable into the PC interface connector (UART1) on 
the SURF development system. 

CAUTION: For service programming, use either the UART1 or UART2 connector. For software upgrades, 9 

use only the UART1 connector. 
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2.3.2.2  Connecting Form Factor Accurate (FFA) phones 1 

Figure 2-2 illustrates how to connect a Qualcomm FFA3100-800, FFA3100-1900, or 
FFA3100-TM to the QPST computer using a TDIP connector and black box. Other types of 
interface cables may be available for the phones you will be using. 

2 

3 

4 

 5 

6 

8 

9 

10 

11 

12 

13 

14 

15 

16 

17 

18 

Figure 2-2  Connecting FFA phones 

2.3.3  Installing QPST software 7 

To install the QPST software: 

1. Use Explorer to locate the file setup.exe in the CD’s root directory. Double-click this file to 
launch the setup program. 

2. To continue the installation, follow the instructions provided by the installer. This could 
include additional reboots depending on your operating system version and that of certain 
system files that QPST may need to update. 

3. After rebooting your computer, relaunch the setup program by double-clicking the file 
setup.exe in the CD’s root directory. When the Setup Complete dialog appears, the 
application has been installed successfully.  

4. To complete installation, click Finish or press enter. 
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2 

3 

4 

5 

7 

8 

9 

10 

11 

12 

13 

14 

15 

16 

17 

18 

19 

20 

21 

22 

23 

24 

26 

27 

28 

29 

30 

2.3.4  QPST initial start 1 

To start QPST for the first time, from the Start menu, select Programs → QPST → QPST 
Configuration. 

This starts the QPST Configuration application, which lets you set up phones and start other 
QPST applications. See Chapter 0 for more information on the QPST Configuration application. 

2.4  QPST server 6 

The QPST server runs when: 

 QPST Configuration application is started 

 Any client application, such as Service Programming, is started and requires the QPST server 

When the QPST server is running, you will see its icon (a globe) on the Windows taskbar. 

 To display the server’s connection status, hold the pointer over the icon. 

 To open a menu for starting the QPST client applications or stopping the QPST, right-click 
the QPST server icon. 

 To open the QPST Configuration application, double-click the QPST icon. 

 To shut down the QPST server, right-click its icon on the Windows taskbar, then select Stop 
QPST Server from the menu that appears. Avoid shutting down the server if any QPST client 
applications are running. 

 To enable or disable the server’s automatic shutdown feature, right-click the server’s icon on 
the Windows taskbar, then select Auto Server Shutdown from the pop-up menu that appears. 
When this menu item appears with a check mark, the server shuts itself off when it detects 
that no client applications are running. Otherwise, the server continues to run until you stop it 
yourself or shut down Windows. 

You can also control the server from the QPST Configuration application as described in 
Section 3.5. 

2.5  QPST help 25 

QPST’s Help menus give you access to online hypertext information about using each application 
in QPST. 

To open QPST Help from any component application, select Contents from the Help menu, or 
press F1. 
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3  QPST Configuration 1 

QPST Configuration is the client application used to monitor the status of: 2 

3 

4 

5 

6 

7 

8 

10 

11 

 Active phones 

 Available serial ports 

 Active clients 

QPST Configuration can run concurrently with other QPST clients. 

To start QPST Configuration, from the Start menu, select Programs → QPST → QPST 
Configuration. 

3.1  Active phones 9 

The Active Phones tab lists the phones currently connected to the QPST server, as shown in  
Figure 3-1. 

 12 

13 Figure 3-1  Active Phones tab dialog 
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Table 3-1 describes the information listed for each connected phone. 1 

2 Table 3-1  Phone information 

Column  Description 

Phone Type of phone connected to the QPST server at this port 
ESN Phone’s electronic serial number 
Phone Number Telephone number assigned to this phone 
Banner Phone’s current banner (user-configurable text) 
Port Serial (COM) port to which the phone is connected and a user-definable label to 

identify the port, if one exists 
 3 

4 

5 

6 

8 

Click any column heading on this tab to sort the entries on the tab by the values in that column, in 
ascending order. Hold down the Shift key while clicking a heading to sort similarly in descending 
order. 

NOTE: Phones that are currently being accessed by another QPST client are listed with a distinctive icon 7 

which indicates that they have been “locked” by that client. 

 This locking indicator is provided to prevent multiple clients that are sharing the same 
pool of phones from disrupting operations in progress by trying to access the same phone 
simultaneously. 

9 

10 

11 

12 

13 

To view the properties of a phone listed in the Active Phones tab, double-click its entry. The 
Phone Properties dialog appears and lists information for the phone, as shown in Figure 3-2. 

 14 

15 

16 

Figure 3-2  Phone Properties dialog  

The icon in Figure 3-2 indicates that a phone is locked by another QPST client. 

NOTE: You cannot get properties for a phone that is in the process of receiving a software download. 17 
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The information in the Phone Properties dialog is described in Table 3-2. 1 

2 Table 3-2  Phone Properties dialog information 

Item Description 

Phone Model designation of the phone 

Port Serial (COM) port to which the phone is connected 

Banner User-definable banner that appears on this phone 

ESN Phone’s electronic serial number, a read-only hexadecimal number set by the 
manufacturer 

MIN Phone’s mobile identification number – The phone number 

MIN (Analog) Phone’s analog mobile identification number – The analog phone number 

State Phone’s CDMA machine state: Sync Channel, Paging Channel, Traffic Channel, and 
so on 

Phone State Phone’s current state of operation: Idle, Initialization, Conversation, and so on 

Version Phone’s software version 

MSM Phone’s ASIC revision number, or “Unknown,” listed with the phone’s vocoder version 
(major_ver.minor_ver) 

Compiled Date the phone’s software was compiled (includes the month, day, year, and 
timestamp) 

Released Date the phone’s software was released (includes the month, day, year, and 
timestamp) 

MOB_P_REV Mobile Protocol Revision, or CDMA air interface protocol version that the phone 
supports 

Slot Cycle Index Phone’s currently set slot cycle index value; controls the frequency at which the phone 
checks the paging channel in slotted sleep mode 

SCM Station class mark that specifies the phone hardware’s transmit and receive 
capabilities 

 3 

4 
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3.2  Ports 1 

Click the Ports tab to display the serial ports available on your computer, as shown in Figure 3-3. 2 

 3 

4 

5 

6 

Figure 3-3  Ports tab 

Table 3-3 describes the information listed for each serial port. 

Table 3-3  Ports tab information 

Column  Description 

Port Available ports on host computer 

State Enabled, Disabled, Not Available, or Pending 

Label A text label you can assign by double-clicking on a port 

Phone Banner text 

Baud Baud rate of the serial port, set automatically by QPST 
 7 

8 

9 

10 

Click any column heading on this tab to sort the entries on the tab by the values in that column, in 
ascending order. Hold down shift while clicking a heading to sort similarly in descending order. 
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Double-click a port’s entry to display the Port Properties dialog, as shown in Figure 3-4. 1 

 2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 

14 

15 

16 

17 

18 

19 

Figure 3-4  Port Properties dialog 

This dialog lets you assign a custom name to the port to more easily identify it in the list. To 
assign a name, type it in the Port Label box and click OK. 

If there are serial ports on your computer that you do not want accessed by QPST applications, 
you can disable them or remove them from the list of available ports entirely by clicking Disable 
or Remove. 

When you select a port and click Disable, QPST checks the port for an attached phone that is 
locked for exclusive access, and will not disable the port if it finds one. A disabled port still 
appears in the list of ports displayed by the Configuration application but is no longer monitored 
for attached phones. 

To return a port that is disabled back into use, click its entry on this tab, then click Enable. 

When you select a port and click Remove, that port’s state is changed to Pending, which means 
that the port is still being monitored and can be used until the server restarts. After you restart the 
server, the port will no longer be monitored or displayed in the list of ports. 

To add a new serial port, or to add one that was previously removed, click its entry on this tab, 
then click Add New Port. The Add New Port dialog appears prompting you for the serial port’s 
designation (COMnumber) and an optional label for the port, as shown in Figure 3-5. 

 20 

21 Figure 3-5  Add New Port dialog 
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3.3  Active Clients 1 

Click the Active Clients tab to see a list of the currently running client applications, as shown in 2 

3 Figure 3-6. 

 4 

5 

6 

7 

8 

9 

10 

Figure 3-6  Active Clients tab 

Clicking any column heading on this tab sorts the entries on the tab by the values in that column, 
in ascending order. Holding down Shift while clicking a heading sorts similarly in descending 
order. 

Additionally, you can double-click a client entry in the list to view that client application’s 
properties, including the version number, as shown in Figure 3-7. 

 11 

12 

14 

15 

16 

Figure 3-7  Client Properties dialog 

3.4  Starting other QPST applications 13 

QPST Configuration provides a Start Clients menu that allows you to run the other QPST client 
applications without having to access the Start menu or the QPST server’s icon on the Windows 
taskbar. 
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2 

3 

4 

5 

6 

7 

8 

10 

11 

3.5  Server menu 1 

QPST Configuration also provides a Server menu that contains two commands:  

 Start/Stop QPST Server  

 Properties 

When the server is running, the Server menu displays a Stop QPST Server command that allows 
you to stop the server. When the server is not running, the Start QPST Server command is 
available on the menu. Together, these commands allow you to cycle the server off and on in case 
you encounter any system problems while running it. 

NOTE: Close any other QPST clients that are running before stopping the QPST server. 9 

If you select Properties from the Server menu, a dialog appears that lists all currently registered 
components of QPST, as shown in Figure 3-8. 

 12 

13 

14 

15 

16 

Figure 3-8  Server Properties dialog 

While this information may be of use to Qualcomm technical support representatives and other 
advanced users, it has little utility for most QPST users. 
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4  Service Programming 1 

Service Programming (SP) is the QPST client application used to provide service programming 
for CDMA phones that contain Qualcomm ASICs. With it, you can save SP data to a file, then 
download the data in that file to multiple phones. 

2 

3 

4 

5 

6 

7 

8 

The SP application accesses settings regardless of the phone’s internal memory implementation. 
It is feature-aware and displays settings pages appropriate to the phone being programmed. 

To start SP, from the Start menu, select Programs → QPST → Service Programming. The first 
window appears, as shown in Figure 4-1. 

 9 

10 

11 

12 

13 

14 

15 

16 

Figure 4-1  Service Programming first window 

NOTE: The tabs and fields that you see in the SP application are specific to the model of phone being 
programmed and may be different from the illustrations in this book. The items listed for each tab 
in this chapter include all options for all phones currently supported by the SP application. If no 
phone is currently connected, a dialog precedes the screen shown in Figure 4-1. 
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The SP client consists of up to 17 settings page tabs: 1 

2 

3 

4 

5 

6 

7 

8 

9 

 Settings  Phone Book or PRI 

 CDMA  Security 

 CDMA-2  Data/Web 

 AMPS  Broadcast SMS 

 System  Multimedia audio 

 Roam  gpsOne® 

 Display  Mobile IP 

 Sounds  Nonaccess Stratum 

 Features/Alerts  
 

The settings on these tabs are described in the following sections. 

The title bar of this application indicates the phone being programmed (by model number), the 
phone’s connection status (online or offline), and the origin of any data read into the application 
(from phone or from file). 

The following buttons, described in Table 4-1, appear at the bottom of the Service Programming 
window and apply to all settings on all tabs. 

Table 4-1  Service Programming window buttons 

Button Description 

Read from Phone Reads the current data from the phone 

Write to Phone Writes all settings to the phone 

Exclusive Access Places a lock on a shared phone, use this to prevent other clients from making 
changes to the phone you are programming, prior to writing to it 

Load from File Reads default or previously saved data to the Service Programming tabs 

Save to File Saves settings to a file you specify 

NOTE: When you click either Write to Phone or Save to File, all current SP parameters are copied to 10 

the QPST server. Any changes you make in the Service Programming tabs during this copy 
process are not written to the phone or saved to file until the next time you click the button. So, 
the contents of the SP tabs at the moment you click the button are what is written or saved, 
regardless of what you type while waiting for the process to complete. 

11 

12 

13 

14 
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4.1  Settings tab 1 

Figure 4-2 depicts the Settings tab. 2 

 3 

4 

5 

6 

Figure 4-2  Settings tab 

The items displayed on the Settings tab are described in Table 4-2. 

Table 4-2  Settings tab information 

Setting Description 

Service Programming 6-digit numerical code that allows access to Service Programming 
Field Service 6-digit numerical code that allows access to the phone’s Debug menus 
Warranty Date Read-only date of manufacture code 
One Time Subsidy Lock 6-digit numerical code that allows limited access to Service Programming; to 

disable it, click the Clear option button; to enable it, click the option button 
next to the text box, then type a 6-digit code; you can also specify a number in 
the Uses box to specify the number of times the code can be used 

Restriction Password 4-digit alphanumeric password used to restrict access to WLL phones 
Slot Cycle Index Value, 0 to 7, corresponding to the slot cycle, the duration and frequency that 

the phone checks the paging channel; 7 is the largest slot cycle value, and the 
default is 1 

Current NAM Drop-down list specifying the NAM to use; number of NAMs supported 
depends on the phone’s software 

Auto NAM When checked, this check box specifies that the NAM is autoselected when 
roaming 

SPC Change Enabled Toggles the ability to change the SPC from a default value to a nondefault one 
through IS-683-A OTASP 
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Setting Description 

Dialing Plan Dialing plan to be used for WLL phones. Settings are:  
 None 
 US 
 India DOT 
 India DOT (Long) 
 Russia, Myanmar 
 Russia (Moscow) 
 Programmable 
 Brazil 

Restriction Level Password restriction levels for WLL phones. Settings are: 
 No Restriction 
 Default Level 1 through Default Level 9 

Roam Messages This area of the tab lets you specify text messages to override the roaming 
messages preprogrammed in the phone. The buttons in this area let you add, 
edit, and delete these messages. Specify a location number to designate the 
memory location of the message you want to replace, along with a message of 
up to 12 characters 

Edit Entry Click this button to edit the roaming message currently selected in the Roam 
Message list 

Add Entry Click this button to specify a new roaming location and message 
Delete  Entry Click this button to delete the roaming message currently selected in the 

Roam Message list 
Delete All Click this button to delete all the roaming messages in the Roam Message list 

4.2  CDMA tab 1 

Figure 4-3 depicts the CDMA tab. 2 

 3 

4 Figure 4-3  CDMA tab 
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The items displayed on the CDMA tab are described in Table 4-3. 1 

2 

3 

Click the NAM buttons to view settings for the various NAMs. 

Table 4-3  CDMA tab information 

Setting Description 

NAM Name Service provider or carrier name, up to 12 characters, for the given 
NAM 

Directory # Phone directory number, 10 decimal digits (0–9) 

Access Overload Class Access overload class for each NAM, normally set to the last digit of 
the CDMA phone number; 10=Test, 11=Emergency, 12–15 are 
reserved; some phones will override settings other than these 

Phone Number  
MCC 

3-digit Mobile Country Code corresponding to the first three digits of 
the IMSI number 

Phone Number 
11_12 

2-digit IMSI_11_12 number corresponding to the fourth and fifth digits 
of the IMSI number 

Phone Number 
IMSI_S 

10-digit CDMA International Mobile Station Identity, the CDMA phone 
number 

Terminated Registration Home 
SID 

Toggles CDMA Mobile-terminated home registration for the given 
NAM 

Terminated Registration Foreign 
SID 

Toggles CDMA Mobile-terminated foreign SID Registration for the 
given NAM 

Terminated Registration Foreign 
NID 

Toggles CDMA Mobile-terminated foreign NID Registration for the 
given NAM 

Channel 
Primary A 

Primary CDMA channel for the given NAM: 11-bit channel number  
(1–2047); default channel is 283 

Channel 
Primary B 

Primary CDMA channel for the given NAM: 11-bit channel number  
(1–2047); default channel is 384 

Channel 
Secondary A 

Secondary CDMA channel for the given NAM: 11-bit channel number 
(1–2047); default channel is 691 

Channel 
Secondary B 

Secondary CDMA channel for the given NAM: 11-bit channel number 
(1–2047); default channel is 777 

EVRC Service Options EVRC 
Enabled 

Toggles the EVRC service options; when enabled, the phone will 
select an EVRC call if the Home Page/Home Orig/Roam Orig type 
matches that of the base station 

EVRC Service Options Home 
Page 

EVRC service options home page type: Wild, IS96A, EVRC, 13K, or 
IS96 

EVRC Service Options Home 
Orig 

EVRC service options home orig type: Wild, IS96A, EVRC, 13K, or 
IS96 

EVRC Service Options Roam 
Orig 

EVRC service options roam orig type: Wild, IS96A, EVRC, 13K, or 
IS96 

 4 
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4.3  CDMA-2 tab 1 

Figure 4-4 depicts the CDMA-2 tab. 2 

 3 
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7 

Figure 4-4  CDMA-2 tab 

The items displayed on the CDMA-2 tab are described in Table 4-4. Click the NAM buttons to 
view settings for the various NAMs. 

Table 4-4  CDMA-2 tab information 

Setting Description 

NAM Name Service provider or carrier name, up to 12 characters, for the given NAM 
Directory # Phone directory number, 10 decimal digits (0–9) 
Access Overload Class Access overload class for each NAM, normally set to the last digit of the 

CDMA phone number; 10=Test, 11=Emergency, 12–15 are reserved; some 
phones will override settings other than these 

True IMSI  
MCC 

3-digit Mobile Country Code corresponding to the first three digits of the 
IMSI number 

True IMSI 
11_12 

2-digit IMSI_11_12 number corresponding to the fourth and fifth digits of the 
IMSI number 

True IMSI 
IMSI_S 

10-digit CDMA International Mobile Station Identity, the CDMA phone 
number 

True IMSI  
Class 1 

If unchecked, allows entry of the Class 0 IMSI into the MCC, 11_12, and 
IMSI_S fields, if checked, allows entry of the Class 1 IMSI into the IMSI field 

IMSI 7–14 digit Class 1 IMSI 
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4.4  AMPS tab 1 

Figure 4-5 depicts the AMPS tab. 2 
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Figure 4-5  AMPS tab 

The items displayed on the AMPS tab are described in Table 4-5. 

Click the NAM buttons to view settings for the various NAMs. 

Table 4-5  AMPS tab information 

Setting Description 

NAM Name Service provider or carrier name of up to 12 characters for the given NAM 
Directory # 10-digit phone directory number 
Access Overload Class Access overload class for each NAM, normally set to the last digit of the CDMA 

phone number; 10=Test, 11=Emergency, 12–15 are reserved; some phones 
will override settings other than these 

Phone Number  AMPS area code and phone number for the given NAM 
Registration Specifies whether the phone will perform an autonomous registration; settings 

are: 
 Disabled 
 Yes 
 Hide – Hide means yes, but makes whereabouts unknown 

1st Paging Channel First analog channel (11-bit value: 1–2047) for the given NAM – 333 for carrier 
A, 334 for carrier B 

Home SID Cellular Service Provider ID – The analog home system ID for the given NAM 
 8 

9 
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4.5  System tab 1 

Figure 4-6 depicts the System tab. 2 
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Figure 4-6  System tab 

The items displayed on the System tab are described in Table 4-6. 

Click the NAM buttons to view settings for the various NAMs. 

Table 4-6  System tab information 

Setting Description 

NAM Name User-selectable name of up to 12 characters for the given NAM 
Directory # 10-digit phone directory number 
Access Overload Class Access overload class for each NAM, normally set to the last digit of the 

CDMA phone number; 10=Test, 11=Emergency, 12–15 are reserved; some 
phones override settings other than these 

Home SID/NID Pairs CDMA Home SID/NID pairs for the given NAM, Cellular; first SID cannot be 
0; all SIDs must be same parity; one pair for PCS; SID can be 0 

Lock SID List SID lockout list for the given NAM 
Preferred Serving System Preferred server – Standard, A Only, B Only, or Home Only 
Preferred Mode Preferred phone mode – Automatic or Digital Only 

 8 
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4.6  Roam tab 1 

Figure 4-7 depicts the Roam tab. 2 
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Figure 4-7  Roam tab 

The items displayed on the Roam tab are described in Table 4-7. 

Click the NAM buttons to view settings for the various NAMs. 

Table 4-7  Roam tab information 

Setting Description 

NAM Name Name for the given NAM of up to 12 characters. 
Directory # 10-digit phone directory number. 
Access Overload Class Access overload class for each NAM, normally set to the last digit of the CDMA 

phone number; 10=Test, 11=Emergency, 12–15 are reserved; some phones 
override settings other than these 

Preferred Roaming 
Enabled 

Toggles the use of the preferred roaming list (PRL) 

File File containing the PRL read from a phone or file, or one you wish to write into 
the phone; click Browse to locate a file; on phones that support preferred 
roaming channels, you must select the File option button to specify this file 

Channels Selecting the Channels option, for WLL phones that support it, allows you to 
enter up to 11 preferred roaming channels on this tab which will be used to 
create a roaming list 

 8 

9 
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4.7  Display tab 1 

Figure 4-8 depicts the Display tab. 2 

 3 

4 

5 

6 

Figure 4-8  Display tab 

The items displayed on the Display tab are described in Table 4-8. 

Table 4-8  Display tab information 

Setting Description 

Banner Banner to be displayed when the phone is idle, up to 12 characters 
Note: If the Banner setting on this tab appears blank after being read from a 
phone, the Banner field may seem like it will not accept any input. This is because 
the field actually contains 12 spaces, and cannot accept any more input. To type 
a banner value in the field, first drag the cursor over the blanks. You can then 
type a banner value of up to 12 characters. 

Backlight Drop-down list of backlight settings specific to the current phone model 
HFK Backlight Drop-down list of hands-free kit backlight settings corresponding to the list of 

Backlight settings 
Menu format Drop-down list of menu format settings, Long or Short 
Book Sort Drop-down list of phone book sorting methods – Location # or Alphabetic 
Language Language selection for the phone menus – English, Español, Français, Português 
Show Time Available Toggles whether the time is displayed, if available 
Auto Hyphen Toggles autohyphen feature 

 7 
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4.8  Sounds tab 1 

Figure 4-9 depicts the Sounds tab. 2 
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7 

Figure 4-9  Sounds tab 

The drop-down list items displayed on the Sounds tab are described in Table 4-9. For all items, 
the available settings correspond to those on the handset. 

Table 4-9  Sounds tab information 

Setting Description 

Earpiece Volume Handset earpiece volume level settings 
Speaker Volume Hands-free kit speaker volume level settings 
Key Beep Volume Keypad beep volume level settings 
Headset Volume Hands-free kit headset volume level settings 
Headset Beep Hands-free kit headset beep volume level settings 
Speaker Beep Hands-free kit speaker key beep volume level settings 
Ringer Volume Ringer volume level settings 
Speaker Ringer Hands-free kit speaker ringer level settings 
Ringer Type Ringer type options 
Key Sound Key sound options, tones or clicks 
Ringer Frequency Specifies the ringer frequency for WLL phones – 17 Hz, 20 Hz (the default), 

25 Hz, or 50 Hz 
 8 

9 
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4.9  Features/Alerts tab 1 

Figure 4-10 depicts the Features/Alerts tab. 2 
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Figure 4-10  Features/Alerts tab 

The items displayed on the Features/Alerts tab are described in Table 4-10. 

Table 4-10  Features/Alerts tab information 

Setting Description 

Auto Answer Toggles autoanswer feature – On or off 
Beep Length Toggles the length, standard or long, of a keypress tone as heard by the 

system that you dialed (usually a voicemail system); the difference may or 
may not be audible in the phone’s earpiece, depending on the phone model 

Auto Retry Drop-down list of autoretry options – Off, 10, 30, or 60 sec 
Voice Privacy Specifies the voice privacy level – Standard or Enhanced 
Vibrate Mode Vibrate mode setting – Ring, Vibrate/Ring, or Vibrate Only 
Roam Ringer Determines ringer type for incoming calls when roaming; settings are Off, 

Roam Ringer, or Prompt 
Full Pref Mode Toggles the full set of preferred mode options on the phone’s network menu 
HFK Voice Recognition 
Enabled 

Toggles voice recognition functionality when used with hands-free kit 

HFK Voice Answer Toggles voice answer functionality when used with hands-free kit 
One Touch Dial When checked, enables one- (or two-) touch dialing feature 
Any Key Answer When checked, pressing any key will answer an incoming call 
Carrier Info Filename Name of the carrier information file to be loaded 
Pay Phone Enabled Toggles Pay Phone feature in WLL phones 
DSP Answer Detect 
Enabled 

Toggles DSP Answer detection in WLL phones 

Bell Modem Enabled Toggles Bell Modem functionality in WLL phones 



 Service Programming 

80-V1400-3 L 37 Qualcomm Confidential and Proprietary  
 MAY CONTAIN U.S. AND INTERNATIONAL EXPORT CONTROLLED INFORMATION  
  

Setting Description 

Dialing Plan File  Lets you specify a dialing plan (DPT) file to be read into a WLL phone 
AFax Mode  Specifies the AFax mode for WLL phones, Standard or QC Mode 
Polarity Reversal 
Timeout 

Specifies the polarity reversal timeout for WLL phones, 0–255 

Send Timeout  Specifies the send timeout for WLL phones, 4–20 
Service Area Alert Toggles whether a sound will alert the user when entering/exiting a service 
Call Fade Alert Toggles whether a sound will alert the user when a call is lost 
Minute Alert Toggles whether a sound will alert the user every 60 sec during a call 
Voice Priv Alert Toggles whether a sound will alert the user when call privacy is not assured 
SMS Alert Controls the short message service alert that sounds when the user receives 

a text message; settings are Off, On, +Reminder 
Alert Sound Levels  
Msg Vol 

Volume setting for alerts on phones 

Alert Sound Levels  
Spkr Msg  

Volume setting for alerts on the hands-free or car kit 

Rental Information 
Increment 

Specifies the increment, in seconds, on which rental billing is based; smallest 
possible increment is 6 sec 

Rental Information Timer Sets the rental billing timer function 
SMS Auto Delete Indicates whether SMS message gets deleted when memory is full and new 

messages arrive 
SMS Reminder Toggles reminder beep when SMS messages arrive 
SMS Time Toggles whether the short message service timestamp will be displayed as 

received or adjusted from UTC time 
 1 
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4.10  Phone Book tab 1 

Figure 4-11 depicts the Phone Book tab. 2 
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Figure 4-11  Phone Book tab 

The columns and buttons displayed on the Phone Book tab are described in Table 4-11. 

Table 4-11  Phone Book tab information 

Column/Button Description 

# Memory location where the number will be stored in the phone 
Name String that identifies this number, up to 12 characters 
Number Phone number of up to 32 digits; can include the pound (#), star (*), and dash  

(–) characters as well as the letters L, P, and T 
Status Whether this number is Public or Secret (restricted) 
Entry Type For WLL phones, this column displays the type of number for each entry in the 

phone book, based on its memory location 
Voice Mail Messages For WLL phones, this read-only field displays the number of waiting voice mail 

messages 
Edit Entry Click this button to edit the selected phone book entry in the resulting Edit Entry 

dialog 
Add Entry Click this button to add a new phone book entry in the resulting Add Entry dialog 
Delete Entry Click this button to delete the selected phone book entry 
Delete All Click this button to delete all phone book entries 
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4.11  Security tab 1 

Figure 4-12 depicts the Security tab. 2 
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Figure 4-12  Security tab 

The items displayed on the Security tab are described in Table 4-12. 

Table 4-12  Security tab information 

Item Definition 

Lock Mode Specifies the phone’s lock mode – Never or On power-up 
Lock Code 4-digit lock code 
Send PIN Send PIN setting – Never or Prompt 
Restrict Phone Toggles the restricted dialing setting for the phone 
# Memory location where the special number will be stored in the phone 
Number Special phone number of up to 32 digits; can include the pound (#), star (*), and dash 

(–) characters as well as the letters L, P, and T; special numbers are those that can 
be dialed when the phone is locked 

Status Whether this special number is Priority, E911, or OTASP 
Edit Entry Click this button to edit the special number entry in the resulting Edit Entry dialog 
Add Entry Click this button to add a new special number entry in the resulting Add Entry dialog 
Delete Entry Click this button to delete the selected special number entry 
Delete All Click this button to delete all special number entries 

 7 

8 
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4.12  Data/Web tab 1 

Figure 4-13 depicts the Data/Web tab. 2 
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Figure 4-13  Data/Web tab 

The items displayed on the Data/Web tab are described in Table 4-13. 

Table 4-13  Data/Web tab information 

Setting Definition 

Service Option Specifies which data standard the phone uses to offer data services; settings are 
Pre-707, Qualcomm Proprietary, or IS-707 

Data QNC Toggles whether the phone uses Quick Net Connect (when checked) or simple packet 
data for packet services 

PPP Detection Toggles PPP autopacket detection 
Main Link Main IP address for the first or second UP.Link™ server 
Backup Link Backup IP address for the first or second UP.Link server 
Access Keys Specifies whether the phone’s preprogrammed UP.Link access key can be reset over 

the air; settings are Keep or Reset 
Current Link Current link (1 or 2) that the browser accesses 
Idle Timer Maximum idle time, in seconds, before the browser disconnects 

 7 
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4.13  Broadcast SMS tab 1 

Figure 4-14 depicts the Broadcast SMS tab. 2 
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Figure 4-14  Broadcast SMS tab 

The items displayed on the Broadcast SMS tab are described in Table 4-14. 

Table 4-14  Broadcast SMS tab information 

Column Description 

Order Shows the position of this entry in the Broadcast SMS table 
Actv Svc Active service (yes/no) 
Selected Selected entry (yes/no) 
Service Category of service for this entry 
Language National language associated with this entry 
Priority Priority of this entry 
Label A label assigned to the entry, maximum of ten characters 
User User activation mode 
Carrier Carrier enable mode 

 7 
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4.14  Multimedia audio tab 1 

Figure 4-15 depicts the Multimedia audio tab. 2 
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Figure 4-15  Multimedia audio tab 

The items displayed on the Multimedia audio tab are described in Table 4-15. 

Table 4-15  Multimedia audio tab information 

Setting Description 

Multimedia level Multimedia audio level (1-4) 
Beep level Multimedia beep level (off, 1-4) 
Volume level Multimedia volume level (1-4 or 1-7 depending on F_UI_SEVEN_LEVEL_SND_BIT 

feature bit setting) 
Handset level Handset level (1-4) 
Headset level Headset level (1-4) 
HFK level Hands-free kit level (1-4) 
Play mode Continuous or single mode 
Repeat  Repeat mode 
Storage device MMC storage device 0-255 
Ringer file Name of ringer files in mobile’s file system (40 characters) 
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4.15  gpsOne 1 

Figure 4-16 depicts the gpsOne tab. 2 
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Figure 4-16  gpsOne tab 

The items displayed on the gpsOne tab are described in Figure 4-16. 

Table 4-16  gpsOne tab information 

Setting Description 

Allowed gpsOne allowed 
Capabilities Capabilities to enable 
PDE IP address IP address of PDE in dotted-decimal format 
PDE port number PDE port number in decimal 
PDE transport Choice of IP or DBM 
Position calculation Choice of Mobile or PDE 

 7 

8 
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4.16  Mobile IP 1 

Figure 4-17 depicts the Mobile IP tab. 2 
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Figure 4-17  Mobile IP tab 

The items displayed on the Mobile IP tab are described in Table 4-17. 

Table 4-17  Mobile IP tab – User profile list 

Setting Description 

profile Profile number (0-5) 
nai Network Access Identifier 
ha spi Mobile Node – Home Agent Security Parameter Index (hexadecimal) 
aaa spi Mobile Node – Authentication Authorization Accounting Security Parameter 

Index (hexadecimal) 
rev tun Reverse tunneling preference 
home Home IP address 
primary Primary Home Agent IP address 
secondary Secondary Home Agent IP address 

 7 
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Table 4-18  Mobile IP tab – User profile control group 1 

Setting Description 

Add Press to add a new user profile; see "Adding or Editing a User Profile" 
Edit Select a user profile and click Edit to modify that profile; see “Adding or Editing a 

User Profile” 
Delete Select the last profile, click Delete to remove it 
Active User Selects the profile Mobile IP will use 

 2 

3 Table 4-19  Mobile IP tab – General settings 

Setting Description 

Mobile IP behavior  Simple IP only – Mobile IP disabled 
 Mob + Simp f/back – Mobile IP Preferred; in the initial M.IP 

registration, if the network does not support Mobile IP, then the 
mobile automatically reverts to Simple IP 

 Mob IP only – Mobile IP only; the mobile will make data calls only 
when the network supports Mobile IP 

Initial registration retry interval Time for the first retry, 1000-2750 ms in 250-ms increments 
RFC2002bis MN-HA 
authenticator calculation 

Selects RFC2002bis MN-HA authenticator calculation method; 
otherwise, RFC2002 (SPI excluded) method is used 

Registration retries Number of times the mobile will retry a registration attempt (0-3) 
Pre-lifetime-expiry reregistration The time before Mobile IP registration expiration to attempt 

reregistration (0-63 min) 
QC optimized dormant handoff Qualcomm protocol revision 6 Mobile IP handoff optimization enable 

 4 

5 

6 

7 

8 

The User Profile list displays all defined user profiles. If you have less than six profiles defined, 
you may click Add to append a new profile to the end of the profile list. You can edit an existing 
profile by double-clicking it, or by selecting it (with a single click) and then clicking Edit or 
pressing enter. If you add or edit a profile, QPST will display the Mobile IP Profile dialog box. 
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Figure 4-18  Dialog box when editing or adding a Mobile IP user profile 

The items displayed on the Mobile IP profile dialog box are described in Table 4-20. 

Table 4-20  Mobile IP profile dialog box 

Setting Description 

NAI Network Access Identifier string, up to 72 characters 
HA Shared Secret Home Agent shared secret; you may retain the value presently in the 

mobile, enter a new value in hexadecimal (up to 16 bytes), or enter a new 
value as text (up to 16 ASCII characters) 

AAA Shared Secret Authentication Authorization Accounting shared secret; you may retain the 
present value or change it as with HA Shared Secret 

MN-HA SPI Mobile Node – Home Agent Security Parameter Index; enter a 
hexadecimal number or leave blank to leave the SPI unset 

MN-AAA SPI Mobile Node – Authentication Authorization Accounting Security 
Parameter Index; same data entry as MN-HA SPI 

Rev Tunnel Preferred Enables reverse tunneling preference 
Home address Home IP address 
Primary HA address Primary Home Agent IP address;  

0.0.0.0 = dynamic, 255.255.255.255 = not set 
Secondary HA address Secondary Home Agent IP address; uses same two reserved values as 

Primary HA address 
OK Click OK to complete adding or changing this profile 
Cancel Click Cancel to abort adding or changing this profile 
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2 Figure 4-19 depicts the Nonaccess Stratum (NAS) tab. 
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Figure 4-19  NAS tab 

The items displayed on the NAS tab are described in Table 4-21. 

Table 4-21  NAS tab information 

Setting Description 

TAC IMEI’s Type Approval Code, 6 digits 
FAC IMEI’s Final Assembly Code, 2 digits 
SNR IMEI’s Serial Number field, 6 digits 
UE RAT UEs Radio Access Technology, GSM only UMTs only, GSM and UMTS 
GSM UE Op Class GSM operating class for the UEC, class A, B, or C 
UMTS UE Op Class UMTS operating class for the UE, class A, B, or C 
UE SMS SMS value associated with the UE, 0-15 
US SM SM value associated with the UE, 0-15 
GSM A5 Algorithms 
Supported 

Which A5 algorithms the UE supports 
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5  Software Download 1 

Software Download is the QPST client application used to: 2 

3 

4 

5 

6 

 Download software to a phone from a Qualcomm Phone Image (.HEX or .MBN) file 

 Backup and restore the NV memory in a Qualcomm phone 

To start Software Download, from the Start menu, select Programs → QPST → Software 
Download. The first window, as shown in Figure 5-1, appears. 

 7 

8 Figure 5-1  Software Download first window 
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5.1  Downloading phone software 1 

Qualcomm phones use either single-image or multi-image software download. Examine the 
phone software release notes to determine the download type. 

2 

3 

4 

5 

6 

8 

9 

10 

11 

12 

For any type of software download, select Auto Backup/Restore to make a backup copy of the 
NV items in your phone before the download starts. QPST will restore the NV items after loading 
the new phone build only if the new build uses a different NV version than the previous build. 

5.1.1  Selecting a phone 7 

To select a phone to download to: 

1. Click Browse located next to the Port description to display the Select Port dialog shown in 
Figure 5-2. 

2. Click to select the phone to which you want to download software. 

3. Click OK. 

 13 

14 Figure 5-2  Select Port dialog 



 Software Download 

80-V1400-3 L 50 Qualcomm Confidential and Proprietary  
 MAY CONTAIN U.S. AND INTERNATIONAL EXPORT CONTROLLED INFORMATION  
  

5.1.2  Specifying a filename 1 

When required by a tab or dialog, you can specify the name of a file in several ways: 2 

3 

4 

5 

6 

7 

 Type a path and filename in the filename control. 

 Click Browse to search for a file. Use the dialog shown in Figure 5-3 to locate the file to 
download. 

 Drag and drop a file from Windows Explorer to the filename control. 

 Select a filename from the filename control’s history list. 

 8 
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Figure 5-3  Find Phone Image dialog 

5.1.3  Single-image download (Software Download tab) 10 

If the phone uses a NOR Flash device, single-image download requires just the phone image 
.HEX file. 

For a NAND Flash, single-image download can send the NAND boot loader, the phone image, or 
both to the phone. You can download a boot loader only to a phone that uses NAND Flash. 

To perform a single-image download, select the Software Download tab. Select the files you wish 
to download with the Phone Image and Boot Image check boxes. Click Browse to locate files to 
download. Note that the boot loader file is usually named BOOT_LOADER.HEX. 

Select the Erase Flash check box only in cases where you know the download will fail because of 
an incompatible Flash configuration. Flash erase is supported only by NAND Flash phones, and 
only on limited phone models. A Flash erase will take several minutes to complete. 
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5.1.4  Multi-image download (Multi-image tab) 1 
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2 

3 

By default, multi-image download (Figure 5-4) sends a set of files, all from the same PC 
directory, to the phone. The files all have standard names. 

 4 
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Figure 5-4  Multi-image tab 

To select a subset of the default set of files, or to alter the filenames or locations, click Advanced. 
Use the dialog shown in Figure 5-5 to select the files you wish to download by selecting the 
check box next to the filename. Click Browse to specify a different filename. 

 9 

10 Figure 5-5  Advanced dialog box 
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If a file requires a header file, you must download both files. 1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

QPST informs you if the partition table in the Flash device does not match the contents of the 
partition.mbn file. If you decide to continue the download, QPST will erase the Flash and 
download all the default image files. 

If you have the phone configured for trusted boot, select the Trusted mode check box on the 
Multi-image tab. In this case, QPST will not download the primary boot loader to the phone 
because the Flash device contains a read-only copy of this module. 

Before sending a file to the phone, QPST compares a hash code generated from the image in the 
phone to the hash code for the file on the PC. If they match, QPST does not send the file. Not all 
phones support hash code calculation. In this case, QPST will always send the file, if enabled. 

See Table 5-1 for additional comments. 

Table 5-1  Multi-image download file types 

File type Default name Comments 

Partition table partition.mbn Required for any download 

Primary boot loader pbl.mbn Required if Trusted mode check box is not 
set 

Qualcomm secondary boot loader 
header 

qcsblhd_cfgdata.mbn  

Qualcomm secondary boot loader qcsbl.mbn  

OEM secondary boot loader 
header 

oemsblhd.mbn Required if oemsbl selected for download 

OEM secondary boot loader oemsbl.mbn  

AMSS modem image header amsshd.mbn Required if AMSS selected for download 

AMSS modem image amss.mbn The modem processor image 

AMSS application processor 
image header 

appshd.mbn Used only by dual-core MSM chipsets; 
required if apps selected for download 

AMSS application processor 
image 

apps.mbn Used only by dual-core MSM chipsets 

AMSS application processor boot 
loader header 

appsboothd.mbn Used only by dual-core MSM chipsets; 
required if appsboot selected for download 

AMSS application processor boot 
image 

appsboot.mbn Used only by dual-core MSM chipsets 
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5.1.5  One-time programmable boot loader (OBL Multi-image tab) 1 

OBL multi-image download (Figure 5-6) is similar to the standard multi-image download but 
uses a special Flash memory device that contains a write-once region used for the OTP boot 
loader. 

2 

3 
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Figure 5-6  OBL Multi-image tab 

This download uses one additional file, the OTP Boot Loader (obl.mbn). You can configure the 
files downloaded with the Advanced dialog (Figure 5-5) in the same manner as multi-image 
download. 

If QPST detects that the OTP boot loader in the phone has been write-protected, it will not 
attempt to send the pbl.mbn file to the phone. 

5.1.6  Canonical EFS download (CEFS tab) 12 

CEFS download (Figure 5-7) does not update the phone image. Instead, it replaces the contents of 
the phone’s file system with the contents of the CEFS file. You must also have a partition file that 
matches the build in the phone, since the download application must know the location of the file 
system in Flash memory. CEFS download does not have an NV backup/restore option since NV 
items are saved in the file system. 

 18 

19 Figure 5-7  The CEFS tab 
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5.1.7  Starting the download 1 

To start the download: 2 

3 

4 

5 

6 

8 

9 

10 

11 

13 

14 

15 

17 

18 

19 

20 

21 

22 

23 

24 

25 

27 

28 

29 

30 

31 

32 

33 

34 

35 

1. Type the SPC for the selected phone in the SPC box. 

2. Click Start. You will see the progress of the download in the lower portion of the QPST 
Software Download window. 

To stop the process at any time, click Abort. 

NOTE: The Auto Backup/Restore check box provides the ability to skip the NV memory save and restore 7 

steps. By default this option is enabled, and the phone's NV items are backed up to a file before 
download and restored afterwards. Disable this option only if you want the phone's NV memory 
to be erased after the download. The phone will not function properly with its NV memory 
erased. 

5.2  Saving and restoring NV memory 12 

Items in a phone’s NV memory are backed up automatically during the download process if the 
Auto Backup/Restore check box is checked. You can also save and restore them manually. The 
Backup and Restore tabs let you select files for backing up or restoring phone settings. 

5.2.1  Backing up NV items 16 

To back up a phone’s NV memory: 

1. Click the Backup tab to access the backup options. 

2. Click Browse located next to the Port description, select the target phone from the resulting 
Select Port dialog, and click OK. 

3. Click BROWSE located next to the QCN File box, use the resulting Find Phone Memory File 
dialog to specify the file in which to save the backup, and click OK. 

4. Type the SPC for the selected phone into the SPC box. 

5. Click Start. You will see the progress of your backup in the lower portion of the dialog. 

To stop the backup at any time, click Abort. 

5.2.2  Restoring NV items 26 

To restore a phone’s NV memory from a backup (QCN) file: 

1. Click the Restore tab to access the restore options. 

2. Click Browse located next to the Port description, select the target phone from the resulting 
Select Port dialog, and click OK. 

3. Click Browse located next to the QCN File box, use the resulting Find Phone Memory File 
dialog to specify the backup file to restore, and click OK. 

4. Type the SPC for the selected phone into the SPC box. 

5. Click Start. You will see the progress of restore process in the lower portion of the dialog. 

To stop the restore process at any time, click abort. 
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5.3  Changing Software Download settings 1 

From the Options menu, select Settings. The Software Download Settings dialog appears, 
containing a text box for specifying an NV Backup Directory, as shown in 

2 

3 Figure 5-8. 
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Figure 5-8  Software Download Settings dialog 

This dialog lets you specify where to write the files that the Software Download application uses 
to back up NV items during downloads. 

To change the directory used for this purpose: 

1. Click Browse. 

2. Select an alternate directory from the resulting dialog. 

3. Click OK to accept your change. 

The Clear Phone Error Log check box on this dialog indicates whether the phone’s error log is 
cleared at the conclusion of a download. This option is enabled by default. To disable it and keep 
the phone’s error log contents after a download, clear this check box before clicking OK. 

The “Startup setting for Auto Backup/Restore is:” check box allows you to select the default 
value for Auto Backup/Restore. When the Software Download application starts, it will use this 
as the initial setting for Auto Backup/Restore on the Software Download tab. 
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11 

Qualcomm ships several boot loader programs (ARMPRG) with QPST. The Software Download 
application will select one to use based on the mobile’s model number. To bypass automatic 
selection place a custom version named armprg.hex in the same folder as the file you wish to 
download, and select “Use custom ARMPRG from phone image directory.” 

Software Download cannot determine which ARMPRG to use for a mobile already in download 
mode. Prior to starting a download to a mobile in this state, select the type of MSM™ (Mobile 
Station Modem) the mobile uses in the selection box next to “ARMPRG to use for mobile already 
in download mode.” 

Software Download will name the NV backup file based on the ESN of the phone. For phones 
that use an R-UIM card, the ESN will come from the card. To bypass this and use the ESN from 
the phone’s NV memory, select the “Use offline mode ESN” check box. 
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6  EFS Explorer 1 

The EFS Explorer application lets you navigate the embedded file system (EFS) of phones that 
support EFS. It is similar in function to the Windows Explorer program on a PC. 

2 

3 

4 

6 

7 

To start EFS Explorer, from the Start menu, select Programs → QPST → EFS Explorer. 

6.1  EFS Explorer toolbar 5 

The EFS Explorer application provides a toolbar that gives you quick access to functions that are 
available on the application’s File and Phone menus, as shown in Figure 6-1. 
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Figure 6-1  EFS Explorer toolbar 

Descriptions of the toolbar buttons are provided in Table 6-1. 

Table 6-1  EFS Explorer toolbar buttons 

Button Function 

 Displays the Phone Selection dialog, which allows you to select a phone for reading or writing 
NV items 

 Requests an exclusive lock on the connected phone so that no other users or applications can 
access it 

 Refreshes the current view of the phone’s EFS 

 Navigates to the parent directory of the current directory 

 Displays the Options dialog used to set EFS Explorer preferences 

 Displays information about the EFS Explorer application 

 12 

13 
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6.2  Selecting a phone 1 

When EFS Explorer launches, it displays a Phone Selection dialog that lists the phones currently 
being monitored by the QPST server, as shown in 

2 

3 Figure 6-2. 
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Figure 6-2  EFS Phone Selection dialog 

To select a phone to explore: 

1. Click to select it from the list of connected phones. 

2. Type an SPC value in the SPC field. 

3. Click OK. 

When you click OK, the EFS Explorer window appears, showing the top, or root, level of the 
phone’s EFS. 

You can change the connected phone anytime by select Connect from the Phone menu to reaccess 
the Phone Selection dialog, as shown in Figure 6-3. 
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Figure 6-3  EFS Explorer application window 

The application’s status bar at the bottom of the window displays the COM port, ESN, and 
software build of the connected phone. In Figure 6-3, the build number is IQE02043. 

The red/green status indicators to the left of the COM port information report the phone’s 
“readiness.” For example, if the phone is reset, the indicator will appear red, and then green again 
when the phone comes back online. 
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As with other QPST applications, you can lock the phone for exclusive access. 1 
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You can navigate in the application by using the mouse or keyboard just as you would in any 
other Windows application directory window. 

The EFS Explorer window is divided into two panes: 

 The left pane contains an expandable directory tree.  

 When you select a folder in the directory tree, a listing of subfolders and files within that 
folder appears in the right pane. 

To move files within the EFS Explorer, you can select one or more files and drag them to another 
directory.  

To copy the files, hold down Ctrl when dropping the files just as you would in any other 
Windows Explorer application. You can drop the files into a folder in the tree pane (on the left) or 
the list pane (on the right). A directory in the tree pane that has subdirectories will automatically 
expand when you drag the mouse over it.  

NOTE: You can only drag files, not directories. 14 

You can choose different display types for the file list (large icons, small icons, list, or detailed 
list) from the View menu. To sort the detail (Name, Size, Type, and so on), click the heading of 
the column by which you want the list sorted. Clicking the column heading toggles between 
ascending and descending order. 

To refresh the current list, press F5. 
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6.3  Creating a directory 1 

When you create a directory in the phone’s EFS, the directory is created on the phone and the file 
structure list is refreshed. 
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7 

To create a directory: 

1. Navigate to the location where you want to create a new directory. 

2. From the File menu, select New → Directory. The Create Directory dialog, as shown in  
Figure 6-4, appears. 
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Figure 6-4  EFS Create Directory dialog 

3. Type a name for the file in the field. 

4. Click OK. 
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6.4  Copying a file to the phone 1 

When you create a new file in the phone’s EFS, you can specify a local or network file to copy to 
the phone and specify the creation date and attribute information. 
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To create a new file: 

1. Navigate to the location where you want to create a new file. 

2. From the File menu, select New → File. The Write File to Phone dialog as shown in  
Figure 6-5 appears. 
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Figure 6-5  Write File to Phone dialog 

3. In the file selection field, do one of the following: 

 Type the fully qualified name of the file on your local PC or network server that you 
want to copy to the phone. 

 Click Browse and navigate to the file. 

4. If needed, edit the file path and name that is displayed in the path/filename field. 

5. Select Overwrite, Attribute, and Creation Date options as needed. 

6. Click OK. 

You can also copy files to the phone by dragging. You can drag a file from any Windows folder 
and drop it into the desired location in the EFS Explorer in either the directory tree or file listing 
display. Remember that you can only drag files, not directories. 
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6.5  Copying a file from the phone 1 

When you copy a file form the phone’s EFS, you are prompted to specify the destination path 
(local or network) for that file. 
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To copy a file from the phone: 

1. Select the file to be copied. 

2. From the File menu, select Copy from Phone. The Copy File from Phone dialog, as shown in 
Figure 6-6 appears. 
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Figure 6-6  Copy File from Phone dialog 

3. In the field, if the destination directory is different from the directory that is displayed, do one 
of the following: 

 Type the fully qualified name of the destination directory. 

 Click Browse and navigate to the destination directory. 

4. Click OK. The selected file is copied from the phone to the location that you specified. 

6.6  Opening a file 15 

To view a file listed in the EFS Explorer, do one of the following: 

 Double-click the file. 

 Click the file and then select File → Open. 

When you do this, the file on the phone is copied temporarily to your PC, and the default viewer 
that is associated with that file type is launched. If no viewer is associated with the file, the 
Windows Open With dialog appears, prompting you to specify an application. The temporary 
files are deleted automatically when the application closes. 
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6.7  Viewing or changing file properties 1 

To view the current properties of a file or modify them, select File → Properties. In the displayed 
File Attributes dialog, shown in 

2 

3 

4 

Figure 6-7, you can change the file’s properties as needed. Click 
OK when finished. 
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Figure 6-7  File Attributes dialog 

6.8  Deleting files or directories 7 

The EFS Explorer application lets you delete files and directories. Directories containing files or 
subdirectories can also be deleted. 

To delete a file or directory, do one of the following: 

 Right-click the file or directory to be deleted, then click Delete from the displayed menu. 

 Click the file, then choose File → Delete. 

 Click the file, then press delete on the keyboard. 

Then, respond to the prompt in the warning dialog that is displayed. 
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6.9  Setting EFS Explorer preferences 1 

You can adjust some program preferences by selecting Edit → Preferences or by selecting the 
appropriate toolbar icon. The EFS Explorer Options dialog appears. 
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4 

Figure 6-8 depicts the 
Operations tab dialog. 
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Figure 6-8  EFS Explorer Options Operations tab dialog 

The Operations tab in this dialog enables you to specify the preferences described in Table 6-2. 

Table 6-2  EFS Explorer Options Operations tab information 

Option Description Default 

Display a warning When selected, displays a warning dialog if the phone you select for 
exploring does not have EFS support 

Selected 

Offline mode When selected, takes the phone offline before attempting operations that 
will modify the file system of the phone 

Selected 

Exclusive only When selected, allows file system operations only if the EFS Explorer 
application has an exclusive lock on the phone 
Note: Unlike the other preferences, this setting is reset to the default 
whenever you close the EFS Explorer. 

Selected 

 9 

10 
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1 Figure 6-9 depicts the Directories tab dialog. 
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Figure 6-9  EFS Explorer Options Directories tab dialog 

The Directories tab dialog enables you to specify the preferences described in Table 6-3. 

Table 6-3  EFS Explorer Options: Directories tab information 

Option Description Default 

Default directory Default directory when exploring will begin / 
Convert backslashes When selected, backslashes (\) will be converted automatically to 

forward slashes (/) for paths that you specify 
Selected 

 6 
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7  QCNView 1 

QCNView is a standalone utility for viewing QCN files, which are used by various QPST utilities 
such as Software Download and Service Programming for backing up and restoring a phone’s NV 
memory.  
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To start QCNView, from the Start menu, select Programs → QPST → QCNView. 

To view a QCN file, choose File → Open and navigate to the file you want to view. You can 
open as many QCN files as needed. Each open file will be displayed in a separate window in 
QCNView, with tabs for Tree View and Text View, as shown in Figure 7-1 and Figure 7-2. 

 9 

10 Figure 7-1  QCNView tree view 
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Figure 7-2  QCNView text view 

In the Tree View tab, you can expand or collapse sections of the tree to display the information of 
interest to you. 

In the Text View tab, you can select a range of text (or select all via Edit → Select All), copy the 
information to the clipboard, and then paste it into a document in another application. You can 
change the font of the Text View tab by choosing Edit → Font. You can save a text-only copy of 
the file by choosing File → Save As. 

QCNView also supports command line usage for saving a text-only copy of a file. To do this, 
invoke QCNView from a command prompt with the switch -s, an input file path, and an output 
file path. For example, to generate an ASCII text file named “outfile.txt” from a binary file 
named “infile.qcn”: 
C:\>QCNView.exe -s infile.qcn outfile.txt 
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8  Roaming List Editor 1 

  NOTE: Numerous changes were made in this chapter. 
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The Roaming List Editor is a standalone utility that displays a phone’s roaming protocol 
information. You may use this tool to edit an existing roaming list file, create a new roaming list, 
or print the contents of a roaming list. 

To start Roaming List Editor, from the Start menu, select Programs → QPST → RL Editor. 

8.1  Supported file types 8 

Roaming List Editor can be used to create, open, and edit the following file types: 

 PRL files [*.prl] 

 MSPL files [*.mspl] 

 MLPL files [*.mlpl] 

 PLMN files  

 EPLMN files [ *.eplmn] 

 UPLMN files [*.uplmn] 

 OPLMN files [*.oplmn] 

 3GPPBST files [*.3GppBst] 

 Technology Order files [*.tot] 

8.2  Operating modes 19 

Roaming List Editor operating modes consist of Edit, Text View, and Command Line, which are 
described in detail in this chapter. 

The Roaming List Editor has two user interface modes: 

 Edit mode 

 Text View mode 

Roaming List Editor always begins in Edit mode for PRL files. All roaming list creation and 
modification occurs in Edit mode. Text View mode presents a roaming list file formatted entirely 
as text. You can see a file in Text View mode by clicking the Text View icon on the toolbar. You 
can save from Text View mode into an ASCII text file (as opposed to the standard binary 
roaming list file). You can subsequently reopen the ASCII file with the Roaming List Editor and 
work with it exactly as you would a standard binary file. 
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NOTE: If you click the Text View icon before entering all required information in the Edit mode 1 

window, a warning appears notifying you of the first field where an entry is missing or incorrect. 
You must correct all errors before using Text View mode. 

Roaming List Editor also supports a third mode, Command Line mode. This mode is useful when 
specific commands need to be applied to a roaming list file without any user interaction. 

8.2.1  Edit mode 6 

All of the file types require an editing record area, and some require editing tabs. The file types 
requiring tab editing are *.mlpl and *.3GppBst. 

Working with records 
To add another record, right-click in the Record area of the window to display the contextual 
menu and select Insert Record as illustrated in Figure 8-1. The new record will be inserted above 

the record you right-clicked, or at the end of the table if you did not click any record. Continue as 
before, selecting a type for the new record and entering values for all corresponding fields. 

 
Figure 8-1  Roaming List Editor Insert Record 

80-V1400-3 L 69 Qualcomm Confidential and Proprietary  



 Roaming List Editor 

80-V1400-3 L 70 Qualcomm Confidential and Proprietary  
 MAY CONTAIN U.S. AND INTERNATIONAL EXPORT CONTROLLED INFORMATION  
  

Deleting, cutting, and copying a record may all be done by right-clicking the record to display the 
contextual menu and selecting the appropriate option as illustrated in 
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Figure 8-2 

 To delete a record from the table, select Delete Record. 

 To cut a record from the table and place it on the clipboard, select Cut Record. 

 To copy a record from the table and place it on the clipboard, select Copy Record. 

 
Figure 8-2  Roaming List Editor Delete, Cut, or Copy Record 

To paste a record from the clipboard into the table, right-click in the acquisition record or system 
record area of the window to display the contextual menu and select Paste Record. The new 
record will be inserted above the record you right-clicked, or at the end of the table if you did not 
click any record. 

NOTE: The Delete, Cut, Copy, and Paste commands apply to the record level, not to individual fields 12 

within a record, even if only one field appears to be selected. 

To delete entries or selections from individual fields, press delete. 
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Working with tabs 1 
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A new tab is created by double-clicking beside the existing tabs as illustrated in Figure 8-3. To 
delete a tab, right-click it and select Delete Tab from the popup menu. A message box appears 
confirming the action. Select Yes and the tab is deleted. A shortcut for deleting the tab is to 
double-click on the tab. Open a tab by left-clicking on it. 

 
Figure 8-3  Roaming List Editor Delete Tab 
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8.2.1.1  PRL files 1 

Roaming List Editor opens in Edit mode with a new empty roaming list file displayed. You can 
then open or create additional roaming lists using the File menu. 
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The Edit mode window is divided into three areas: 

 Properties – see Section 8.2.1.1.1 

 Acquisition Records – see Section 8.2.1.1.2 

 System Records – see Section 8.2.1.1.3 

The Edit mode of the Roaming List Editor is illustrated in Figure 8-4. 

 
Figure 8-4  Roaming List Editor Edit mode for PRL files 
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8.2.1.1.1  Properties 1 

As illustrated in Figure 8-5, the upper area of the Edit mode window defines roaming list 
properties. These include Roaming List Type, Preferred Only, Default Roaming Indicator, and 
Preferred Roaming List ID. 
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Figure 8-5  Roaming List Editor Edit mode – Properties 

The Roaming List Editor supports four roaming list file types – IS-683A, IS-683B, IS-683C, and 
IS-683D. You can change the type by selecting from the Roaming List Type drop-down list in the 
Properties area. Changing from a newer standard to an older standard, e.g., D to C, may result in 
data loss if any records in the file apply only to the newer standard. The Roaming List Editor will 
display a warning before making such a conversion. 

The Preferred Only check box specifies that System Records with the Neg/Pref field set to “Neg” 
are to be ignored. 

The Default Roaming Indicator field specifies which roaming indicator is displayed by default. 
Each System Record can have its own Roaming Indicator setting as well. 

The Preferred Roaming List ID field specifies the System Record index of the preferred roaming 
list. 
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8.2.1.1.2  Acquisition records 1 

As illustrated in Figure 8-6, the middle area of the Edit mode window defines acquisition records 
for the roaming list. 
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Figure 8-6  Roaming List Editor Edit mode – Acquisition records 

An acquisition record contains parameters that the mobile station can use to acquire a system. 
Each type of acquisition record is tailored for use in acquiring a particular kind of system. 

Select the acquisition record type from the drop-down list in the first field. Values for the other 
fields can then be filled in, according to the acquisition type. 

Create new acquisition records as needed (using the contextual menu, right-click and select Insert 
Record) to define settings for all desired acquisition types. 

Note that the field titles at the top of the acquisition record table are updated according to the type 
of record that is currently selected. 

The acquisition record table must contain at least one valid acquisition-type definition. 



 Roaming List Editor 

80-V1400-3 L 75 Qualcomm Confidential and Proprietary  
 MAY CONTAIN U.S. AND INTERNATIONAL EXPORT CONTROLLED INFORMATION  
  

Permissible entries 1 
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The Roaming List Editor ensures that the value in each field of each acquisition record is valid 
for the selected acquisition type. Table 8-1 describes the permissible values in all types of 
acquisition records. 

NOTE: The “Roaming list format” column specifies the oldest format in which this acquisition type is 5 

available; e.g., “A” means the acquisition type is available in IS-683A and higher; “C” means the 
acquisition type is available in IS-683C and higher. 

Table 8-1  Permissible values in acquisition records 

Acquisition type Field Permissible values Roaming 
list format 

Analog Cellular  System  Select A, B, or Both.  A  

CDMA Cellular 
(standard)  

System  Select A, B, or Both.  A  

Channel  Select Pri, Sec, or Both.  A  

CDMA Cellular 
(custom)  

Channel 1-32  Enter a channel value within the range 1 to 799, 
801 to 1039, 1041 to 1199, or 1201 to 1600, 
inclusive. 
A minimum of one channel must be specified.  

A  

CDMA Cellular 
(preferred)  

System  Select A, B, or Both.  A  

CDMA PCS 
(blocks)  

Block 1-6  Select A, B, C, D, E, F, or Any. 
A minimum of one block must be specified.  

A 

CDMA PCS 
(channels)  

Channel 1-32  Enter a channel value within the range of 25 
to 1175, inclusive. 
A minimum of one channel must be specified.  

A 

JTACS CDMA 
(standard)  

System  Select A, B, or Both.  B 

Channel  Select Pri, Sec, or Both.  B 

JTACS CDMA 
(custom)  

Channel 1-32  Enter a channel value. 
A minimum of one channel must be specified.  

B 

2GHz Band 
(channel)  

Channel 1-32  Enter a channel value. 
A minimum of one channel must be specified.  

B 

CDMA Generic Note: A minimum of one band/channel pair must be specified. 

 Band 1-16  Select a band class from the menu –  
800-MHz-Cellular, PCS, TACS, JTACS, 
Korean-PCS, NMT-450, IMT-2000, or  
700-MHz-Cellular. 

C 

 Channel 1-16  Enter a channel value for the selected band 
class. 

C 

HDR Generic Note: A minimum of one band/channel pair must be specified. 

 Band 1-16  Select a band class from the menu –  
800-MHz-Cellular, PCS, TACS, JTACS, 
Korean-PCS, NMT-450, IMT-2000, or  
700-MHz-Cellular. 

C 

 Channel 1-16  Enter a channel value for the selected band 
class. 

C 
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Acquisition type Field Permissible values Roaming 
list format 

GSM Generic  Band 1-32  Select a band class from the menu –  
GSM-450, GSM-480, GSM-750, GSM-850,  
P-GSM-900, E-GSM-900, R-GSM-900,  
DCS-1800, or PCS-1900. 
A minimum of one band must be specified.  

D 

UMTS Generic Note: A minimum of one band/UARFCN pair must be specified. 

 Band 1-16  Select a band class from the menu –  
2.1GHz, 1.9GHz, or 1.7GHz. 

D 

 UARFCN 1-16  Enter a UTRA Absolute Radio Frequency 
Channel Number, or leave blank to indicate that 
no UARFCN is included. 

D 

GSM/UMTS Pref  Preferred System  Select GSM or UMTS.  D 

GSM/UMTS Pref 
Generic 

Note: A minimum of one system/band/UARFCN triplet must be specified. 

System 1-10  Select a system from the menu – GSM, UMTS. D 

 Band 1-10  Select a band class from the menu. 
If system is GSM – GSM-450, GSM-480,  
GSM-750, GSM-850, P-GSM-900, E-GSM-900, 
R-GSM-900, DCS-1800, or PCS-1900. 
If system is UMTS – 2.1GHz, 1.9GHz, 1.7GHz. 

D 

 UARFCN 1-10  If system is UMTS, enter a UTRA Absolute 
Radio Frequency Channel Number, or leave 
blank to indicate that no UARFCN is included. 

D 

Undefined  Data Length  Enter a value for the number of bytes of 
undefined data in the record. These bytes will 
all be set to 0. 

D 

8.2.1.1.3  System records 1 

As illustrated in Figure 8-7, the lower area of the Edit mode window defines system records for 
the roaming list. 
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Figure 8-7  Roaming List Editor Edit mode – System records 

A system record contains parameters that the mobile station can use for identifying an acquired 
system, for determining whether an acquired system is the optimal system on which to operate, 
and for determining the mobile station’s roaming status. 
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Select the system record type from the drop-down list in the first field. Values for the other fields 
can then be filled in according to the system type. 
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Create new system records as needed (using the contextual menu, right-click and select Insert 
Record) to define settings for all desired system types. Each system record must reference a valid 
acquisition record (using the Acquisition Index field). Multiple system records may reference the 
same acquisition record, but not all acquisition records need to be referenced by system records. 

Note that the field titles at the top of the system record table are updated according to the type of 
record that is currently selected. 

The system record table must contain at least one valid system type definition. 

Permissible entries 
The Roaming List Editor ensures that the value in each field of each system record is valid for the 
selected system type. Table 8-2 describes the permissible values in all types of system records. 

NOTE: The “Roaming list format” column specifies the oldest format in which this system type is 13 

available; e.g., “A” means the system type is available in IS-683A and higher; “C” means the 
system type is available in IS-683C and higher. 

Table 8-2  Permissible values in system records 

System type Field Permissible values Roaming 
list format 

Any  Neg/Pref Select Pref or Neg. 
 Pref – Mobile station is allowed to operate on the 

system associated with this record. 
 Neg – Mobile station is not allowed to operate on 

the system associated with this record. 

A 

 Geography Select New or Same. 
Same means the geographical region is the same as 
the previous system record. 
Note that the value of this field in the first system 
record is always New. 

A 

 Priority Select Same or More. 
More means the system associated with this system 
record is more desirable than the system associated 
with the next system record. 
If this is the last system record in a geographical 
region, or if the Neg/Pref field in the next system 
record is Neg, this field has no meaning. 

A 

 Acq Index  Enter an acquisition index corresponding to the Index 
field in the acquisition table for the record associated 
with this system record. 
Note that multiple system records can reference the 
same acquisition record. 

A 

 Roam Indicator Enter a roaming indicator value within the range 0 
to 255, inclusive. 
Note that this value overrides the default setting in the 
Properties area. 

A 
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System type Field Permissible values Roaming 
list format 

Any (cont.) Assn Incl  Select No or Yes. 
Yes means this system record is part of a set that 
shares a PN offset assignment (co-located) or which 
can reach the same PSDN (associated), as specified 
by the three fields, Assn Tag, PN Assn, and Data 
Assn. 

C 

 Assn Tag  Enter a number that specifies the set to which this 
system record belongs. All of the system records in the 
same geography with the same Assn Tag form a set. 

C 

 PN Assn  Select No or Yes. 
Yes means the system identified by this system record 
has the same PN assignment as other systems in the 
same geography with the same Assn Tag and whose 
PN Assn field is also Yes. 

C 

 Data Assn  Select No or Yes. 
Yes means the system identified by this system record 
can reach the same set of PDSNs as other systems in 
the same geography with the same Assn Tag and 
whose PN Assn field is also Yes. 

C 

95(A,B)/1x  SID  Enter a system ID value within the range 1 to 32767, 
or enter 0 to indicate a wild card system ID.  

A 

 NID  Enter a network ID value within the range 0 to 65534, 
or enter 0 to indicate a wild card network ID 

A 

IS-856  Subnet ID  Enter a subnet ID value formatted according to the 
IPv6 protocol – a 128-bit address composed of eight 
16-bit values separated by colons, followed by a slash 
and a length value within the range 0 to 127. Enter /0 
to indicate a wild card subnet ID. 
It is not necessary to specify leading zeros for a 
subfield, but there must be at least one numeral in 
every subfield, e.g.,  
0000:0000:0000:0000:0000:0000:0100:0000/104 is 
equivalent to 0:0:0:0:0:0:100:0/104. 
Only the number of bits specified by the length are 
actually written to the roaming list file. 

C 

PLMN-based 
(public land 
mobile network)  

PLMN Type  Select a value from the menu – Select Mode, PLMN 
Only, PLMN+Single LAC, or PLMN+Multi-LAC. 
The setting for this field determines the types of the 
remaining fields in the record. 
 Select Mode – PLMN and LAC are not included 
 PLMN Only – PLMN is included but LAC is not 
 PLMN+Single LAC – PLMN and LAC are included 
 PLMN+Multi-LAC – PLMN and multiple LACs are 

included 

D 

 PLMN  (This field is defined only if the PLMN Type field is 
Select Mode.) 
Select a value from the menu – Any PLMNs, Allowed 
PLMNs, or Home PLMN 
 Any PLMNs – Limited-service network selection 

mode 
 Allowed PLMNs – Automatic network selection 

mode 

D 
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System type Field Permissible values Roaming 
list format 

PLMN-based 
(public land 
mobile network) 
(cont.) 

MCC (mobile 
country code)  

(This field is defined only if the PLMN Type field is not 
Select Mode.) 
Enter a value for the MCC portion of the PLMN. The 
format is three decimal digits. 

D 

 MNC (mobile 
network code)  

(This field is only defined if the PLMN Type field is not 
Select Mode.) 
Enter a value for the MNC portion of the PLMN. The 
format is two or three decimal digits. If only two digits 
are specified, the third digit will be stored as 0xF.  

D 

 Network Sel 
Mode  

(This field is only defined if the PLMN Type field is not 
Select Mode.) 
Select a value from the menu – Manual or Automatic. 

D 

 LAC (Location 
Area Code)  

(This field is only defined if the PLMN Type field is 
PLMN+Single LAC.) 
Enter a value for the LAC of the system associated 
with this record. 

D 

 LAC Count  (This field is only defined if the PLMN Type field is 
PLMN+Multi-LAC.) 
Enter a value within the range 1 to 15 for the number 
of LACs included in this record. 

D 

 LAC 1-15  (These fields are only defined if the PLMN Type field is 
PLMN+Multi-LAC, and the number is dependent on 
the value of the LAC Count field.) 
Enter a value for the corresponding LAC of the system 
associated with this record. 

D 

Undefined  Data Length  Enter a value for the number of bytes of undefined 
data in the record. These bytes will all be set to 0. 

D 
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8.2.1.2  MSPL files 1 

You can create MSPL files using the file menu or the toolbar (see red circle in Figure 8-8). To 
open an existing file, use the file menu or the toolbar (see Section 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 
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15 

16 
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19 

8.4). The MSPL window 
consists of the following sections: 

 Properties 

 ID view 

 
Figure 8-8  Roaming List Editor Edit mode for MSPL files 

Properties 
The properties section consists of MMSS Revision and MSPL Revision. These fields are 
common for all the tabs. These fields are mandatory. 

ID view 
This part of the screen is multi-tabbed. MSPL ID is common for all the records with in the tab. It 
is a mandatory field for each tab. On opening a new file, a single tab with a single record is 
created with default values. Each record consists of five fields – Sys Type, Priority Class, Sys 
Priority, High Pri Search Time, and Network Cap. They are filled using the drop-down box. 

The ID indicated at the top of the tab reflects the MSPL ID. It is initialized onto “-1” on create. 
When an MSPL ID field is updated, it is reflected correspondingly. This helps in navigation since 
the MSPL ID (green boxes in Figure 8-8) need not be sequential. 
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8.2.1.3  MLPL files 1 

You can create MLPL files using the file menu or the toolbar (see red circle in Figure 8-8). To 
open an existing file, use the file menu or the toolbar (see Section 
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8.4). The MLPL window 
consists of the following sections: 

 Properties 

 ID view 

 
Figure 8-9  Roaming List Editor Edit mode for new MLPL files 

Properties 
The properties section consists of MMSS Revision, MLPL Version, and MSPL ID. These fields 
are common for all the tabs and are mandatory.  

ID view 
This part of the screen is multi-tabbed. Mcc, Mnc, and MSPL Index fields are for all the records 
within the tab. Mcc and Mnc are not mandatory fields, but MSPL Index is mandatory. The wild 
card Mnc “FFF” is supported. Records in the view are also not mandatory. However, in each tab, 
there should be at least one completed row or Mcc or Mnc field. The record ID on the tab (labeled 
“Record”) is sequential. Some of the records contain explicit Mcc and Mnc fields, e.g., GSM Sys 
type. The Mcc and Mnc for these records should be mandatorily in 3-digit format.  
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On opening a new file, a single tab with a single record is created with Sys Type Field (see 1 

2 

3 

4 

Figure 8-10). On selection of the system type, fields related to the system type are enabled. 

 
Figure 8-10  Relevant fields enabled on selecting Sys Type 
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8.2.1.4  PLMN files 1 

Three types of PLMN files are supported – EHPLMN, OPLMN, and UPLMN. You can create 
any of these file types using the file menu or the toolbar (see 

2 
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13 

Figure 8-11; EHPLMN is denoted 
by a red circle, OPLMN by an orange circle, and UPLMN by a yellow circle). To open an 
existing file, use the file menu or the toolbar (see Section 8.4). The file type selected appears as a 
caption of the view (see green box in Figure 8-11). 

PLMN view is single-tabbed with a record view. All PLMN file types contain Mcc and Mnc 
Fields. OPLMN and UPLMN additionally contain UMTS Present, LTE Present, and GSM 
Present Fields. All fields are mandatory. 

On opening a new file, a single record is created. Mcc and Mnc are initialized to 0 and, if present, 
the other three fields are initialized to “NO.” PLMN files do not support Mnc wild cards. 

 
Figure 8-11  Roaming List Editor Edit mode for new EHPLMN files 
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Figure 8-12 shows Edit mode for new OPLMN files. 1 

2 

3 

 
Figure 8-12  Roaming List Editor Edit mode for new OPLMN files 
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8.2.1.5  Technology order table files 1 

You can create a new technology order table file using the file menu or the toolbar (see red circle 
in 

2 

3 

4 

5 

6 

7 

8 

9 

Figure 8-13). To open an existing file, use the file menu or the toolbar (see Section 8.4). 

The Technology Order Table View is single-tabbed with a record view. It contains a single Rat 
ID field in each record. On opening a new file, a single record initialized to cdma-1x is created. 
The value of the Rat ID field is unique within a Technology Order Table file, i.e., the same value 
cannot be repeated in more than one row of the same file. 

 
Figure 8-13  Roaming List Editor Edit mode for new technology order table files 
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8.2.1.6  3GPPBST files 1 

You can create new 3GPPBST files using the file menu or the toolbar (see red circle in 2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

Figure 8-14). To open an existing file, use the file menu or the toolbar (see Section 8.4). The 
3GPPBST file window consists of the following sections: 

 Properties 

 ID view 

 
Figure 8-14  Roaming List Editor Edit mode for new 3GPPBST files 

Properties 
The properties section consists of the Version field. It is common for all the tabs and is a 
mandatory field. 
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ID view 1 

2 
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This part of the screen is multi-tabbed. Mcc field is common for all the records within the tab and 
is a mandatory field. At least one record should be present in each tab in the ID View. On 
opening a new file, a single tab with a single record is created, with Rat ID initialized to GERAN 
and Num Band Channels to 0. The Bst ID on the tab (labeled “Bst”) is sequential (see 
Figure 8-15). 

Upon increasing the number of band channels, an equivalent number of Band ID and number of 
channels fields are created. Band ID is uninitialized and the number of channels is initialized to 0. 
The drop-down contents of Band ID are determined based on the Rat ID. Upon changing the Rat 
ID, Band ID values get mapped to the corresponding band ID for the new Rat ID. Upon 
increasing the number of channels, an equivalent number of channels fields are created. 

 
Figure 8-15  Relevant fields get enabled on filling data 



 Roaming List Editor 

80-V1400-3 L 88 Qualcomm Confidential and Proprietary  
 MAY CONTAIN U.S. AND INTERNATIONAL EXPORT CONTROLLED INFORMATION  
  

8.3  Text View mode 1 

Text View mode presents a roaming list file formatted entirely as text, as shown in Figure 8-16. 
You can see a file in Text View mode by clicking the Text View icon on the toolbar. You can 
save from Text View mode into an ASCII text file (as opposed to the standard binary roaming list 
file). You can subsequently reopen the ASCII file with the Roaming List Editor and work with it 
exactly as you would a standard binary file. 

2 

3 

4 

5 

6 

8 

9 

NOTE: If you click the Text View icon before entering all required information in the Edit mode 7 

window, a warning is displayed notifying you of the first field where an entry is missing or 
incorrect. You must correct all errors before using Text View mode. 

 10 

11 Figure 8-16  Roaming List Editor Text View mode 
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8.4  Operating conventions 1 

8.4.1  Use of mouse 2 

Use your computer’s mouse with Roaming List Editor’s Edit mode as you would when using any 
Windows application. 

3 

4 

5 
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 Left-click to select a toolbar icon, menu item, or field in the Roaming List Editor, or to switch 
the focus out of a field 

 Right-click to open a pop-up menu for edit functions 

8.4.2  Toolbar 8 

The Roaming List Editor toolbar, shown in Figure 8-17, allows you to: 

 Create a new roaming list in any of the supported formats (e, d, c, b, a) 

 Create new file types 

 T – Technology order 

 G – 3GPPBST 

 M – MSPL 

 L – MLPL 

 E – EHPLMN 

 O – OPLMN 

 U – UPLMN 

 Open a roaming list file or save a roaming list file 

 Print a roaming list; printing is available only in Text View mode 

 View a roaming list in Text View mode  

 Display Roaming List Editor Help topics 

You can show or hide the toolbar by selecting View → Toolbar. 

 
Figure 8-17  Roaming List Editor toolbar 
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8.4.3  Special keys 1 

Use the tab and enter keys to accept entered data and move through fields in each area of the 
Edit mode window. In a field containing a drop-down list, press enter to open the list, and then 
use the up and down arrow keys to highlight an entry in the list. Pressing enter  again selects the 
highlighted item. 

The left and right arrow keys move the focus through the cells of a row. The up and down keys 
move the focus within an open drop-down list. 

Use esc if you are typing a new entry in a table field and want to revert to the previous value. 

Use delete to clear an entry from a table field. 

8.5  Command Line mode 10 

Roaming List Editor can also be used in Command Line mode. This mode is useful when specific 
commands need to be applied to a roaming list file without any user interaction. 

To use the Command Line mode, invoke the Roaming List Editor from a command prompt with 
one of the supported command line options described in the following paragraphs. 

Convert file from Binary to ASCII: -f 
This option takes a binary file as input and generates an ASCII text file as output. For example, to 
generate an ASCII text file named “outfile.txt” from a binary file named “infile.prl”: 
C:\>RLEditor.exe -f infile.prl outfile.txt 

If the command fails to execute properly (perhaps due to a malformed input file), no output file 
will be generated. 

Convert file from ASCII to Binary: -u 
This option takes an ASCII text file as input and generates a binary file as output. For example, to 
generate a binary file named “outfile.prl” from an ASCII text file named “infile.txt”: 
C:\>RLEditor.exe -u infile.txt outfile.prl 

If the command fails to execute properly, no output file will be generated. 

NOTE: The format of the input ASCII text file must strictly follow the format generated by the Roaming 26 

List Editor when it saves an ASCII text file; any deviation from this format will result in failure 
of the command. A suggested method to ensure adherence to the proper format is to start by 
converting a binary file into an ASCII text file, modifying that file as needed, then converting it 
back to binary. 
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9  Using the QPST Automation Server 1 

This chapter describes the Automation Server and documents the interfaces and methods 
available for a script to perform automation functions. 

2 

3 

6 

7 

8 

9 

10 

NOTE: All examples use the Perl language. 4 

9.1  The QPST Automation server 5 

The Automation Server is an application that acts as an interface between a scripting language (or 
another application) and the QPST port server. The QPST port server allocates and monitors ports 
that you assign to it through the QPST Configuration application. The Automation Server’s user 
interface allows you to select a port for your script to use, and to monitor the progress of 
commands for errors (Figure 9-1). 

 11 

12 

13 

14 

Figure 9-1  QPST Automation Server user interface 

The Automation Server user interface is invisible by default. You must enable it with 
ShowWindow as discussed in Section 9.4.2. 
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The upper window (Ports) allows you to select a COM port by clicking the row associated with 
that port. Your script can retrieve a pointer to the Port Proxy interface for the selected port with 
GetSelectedPort. You can only select ports that you have added through the QPST Configuration 
application. If your script does not make the user interface visible, use GetPort to retrieve a Port 
Proxy interface for a named COM port. 
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The lower window (Status) displays the processing status of the Automation APIs. 

9.2  Using automation with other languages 7 

The automation interfaces are derived from the Microsoft IDispatch interface. 

C++ clients should use the IDispatch interface rather than an interface’s v-table. That is, you 
should create stubs that call IDispatch methods (GetIDsOfNames, Invoke) rather than link 
directly against the interface’s v-table. The interfaces are intended for scripting languages that use 
late binding, such as Perl. New methods may be added to an interface in the future. This will not 
affect Perl applications, but would cause C++ clients that used v-table binding to fail. 

9.3  The root automation interface 14 

Starting the QPST Automation server through a Perl script will return a pointer to the server’s 
root automation interface: 

 

use Win32::OLE; 

use Win32::OLE::Variant; 

$prod_id = "QPSTAtmnServer.Application"; 

eval 

{ 

  $qpst = Win32::OLE->GetActiveObject($prod_id) 

}; 

die "$prod_id not installed" if $@; 

unless (defined $qpst) 

{ 

  $qpst = Win32::OLE->new($prod_id, sub {$_[0]->Quit;}) or die "Oops, 
cannot start $prod_id"; 

} 

if (defined $qpst) 

{ 

  # $qpst now set to the Automation server root interface 

  # Code to use the automation interface goes here 

 

  undef $qpst; 

} 

 

You use the root interface to obtain pointers to other interfaces and control basic QPST 
operations. 
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9.4  Error checking 1 

If you call a method that returns an interface, you should check for success by ensuring that the 
method “defined” the interface. See the example in Section 
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9.3 (if (defined $qpst)). 

Each method returns status to the Perl interpreter. If Win32::OLE->LastError() + 0 return a 
nonzero number (the +0 forces Perl to evaluate the return status as a number), then the interface 
method encountered an error. The nonzero value returned by LastError() is in the Microsoft 
HRESULT format. 

The following subsections describe the root automation interface methods. 

9.4.1  GetPortList() 9 

GetPortList returns an interface that describes the ports currently allocated to QPST. The method 
takes a snapshot of the port status, and the interface provides functions to return the cached 
information to your script. See Section 9.5 for details. 

 

$port_list = qpst->GetPortList(); 

9.4.2  ShowWindow() 15 

This method shows the Automation Server user interface. When the Automation server starts, its 
user interface is invisible by default. 

 

$qpst->ShowWindow(); 

9.4.3  HideWindow() 20 

This method hides the Automation Server user interface. 
 

$qpst->HideWindow(); 

9.4.4  Quit() 24 

This method tells the Automation server to quit. 
 

$qpst->Quit(); 
 

Generally, it is called by a Perl destructor: 
 

Win32::OLE->new($prod_id, sub {$_[0]->Quit;}) 

9.4.5  GetPort(comPort) 32 

This method returns a pointer to the Port Proxy interface for the port named comPort. The Port 
Proxy interface can return additional interfaces that provide Software Download, EFS, and 
provisioning support functions. See Section 9.4.7 for details. 

 

$port = $qpst->GetPort("COM1"); 
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9.4.6  GetSelectedPort() 1 

GetSelectedPort returns a Port Proxy interface for the port selected in the Automation Server’s 
user interface. See Section 
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9.6 for details. 
 

$port = $qpst->GetSelectedPort(); 

9.4.7  GetCOMPortList() 6 

GetCOMPortList returns a COM Port List interface. This interface lists all the COM ports on 
your system and indicates port type and whether the port has been allocated to QPST. See 
Section 9.5 for details. 

 

$com_list = $qpst->GetCOMPortList(); 

9.4.8  AddPort (comPort, portLabel) 12 

This method adds the port named comPort to QPST with the label portLabel. It performs the 
same function as the Configuration Application Add New Port button. 

 

$qpst->AddPort("COM2", "Serial Port 2"); 

9.4.9  RemovePort(comPort) 17 

This method removes the port named comPort from QPST. It performs the same function as the 
Configuration Application Remove button. 

 

$qpst->RemovePort("COM2"); 

9.4.10  EnablePort(portName) 22 

This form of EnablePort returns the current state of the port named portName; 0 = port disabled, 
nonzero = port enabled. It performs the same function as the Configuration Application Enable 
and Disable buttons. 

You should examine the EnablePort property only if the port is assigned to QPST 
(AssignedToQPST on the COM Port List interface returns nonzero for this port). 

 

$state = $qpst->EnablePort("COM2"); 

9.4.11  EnablePort(portName, newState) 30 

This command changes the state of the port named portName to newState. 0 = disable the port, 
1 = enable the port. You should change this property only if this port is assigned to QPST. 

 

$qpst->SetProperty('EnablePort', "COM2", 1); 

(The "$qpst->{EnablePort("COM2")} = 1;" syntax does not compile in Perl.) 
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9.5  Port List interface 1 

The Port List interface returns a snapshot of information about a port. The information is cached 
at the time GetPortList() is called. 
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You can retrieve this interface from the Automation Server root interface: 
 

$port_list = qpst->GetPortList(); 

If (defined $port_list) 

{ 

} 

9.5.1  Version() 10 

This method returns the version of QPST as a string. 
 

$version = $port_list->Version(); 

9.5.2  PhoneCount() 14 

This method returns the count of COM ports allocated to QPST. 
 

$port_count = $port_list->PhoneCount(); 

NOTE: For the remaining functions in this section, 0 <= $i < $port_count. 18 

9.5.3  PortName($i) 19 

This method returns the name of the COM port as a string. 
 

$port_name = $port_list->PortName($i); 

9.5.4  PortLabel($i) 23 

This method returns the QPST port label. 
 

$port_label = $port_list->PortLabel($i); 

9.5.5  IsUSB($i) 27 

This method returns 0 if the port is serial, 1 if the port is USB. 
 

$is_usb = $port_list->IsUSB($i); 
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9.5.6  PhoneMode($i) 1 

This method returns the mode of the phone as detected by QPST. Modes are listed in Table 9-1. 2 

3 

4 

5 

 
$phone_mode = $port_list->PhoneMode($i); 

Table 9-1  Phone mode values 

Phone mode Meaning 

0 No phone detected 

2 Phone in Download mode 

3 Phone in Diagnostic mode 

4 Phone offline and in Diagnostic mode 

6 Phone in streaming Download mode 

9.5.7  PhoneStatus($i) 6 

This method returns the status of the phone. Status values are listed in Table 9-2. 7 
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11 

 

$phone_status = $port_list->PhoneStatus($i); 
 

Table 9-2  Phone status values 

Phone status Meaning 

0 No phone detected 

5 Phone ready 

NOTE: For the remaining functions, phone mode must be either 3 or 4 and status must be 5. 12 

9.5.8  ModelNumber($i) 13 

This method returns the phone’s mobile model number. 14 
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$model_number = $port_list->ModelNumber($i); 

9.5.9  BuildId($i) 17 

This method returns the phone’s build information. 
 

$build_id = $port_list->BuildId($i); 

9.5.10  ESN($i) 21 

This method returns the ESN of the phone on the port. 
 

$esn = $port_list->ESN($i); 
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9.5.11  IMEI($i) 1 

This method returns the phone’s IMEI. 2 

3 

4 

6 

7 
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11 

12 
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34 

 

$imei = $port_list->IMEI($i); 

9.5.12  MEID($i) 5 

This method returns the phone’s MEID. 
 

$meid = $port_list->MEID($i); 

9.6  The Port Proxy interface 9 

This interface works with the active port. It can return pointers to other interfaces. To get a 
pointer to the Port Proxy interface, use the root QPST interface: 

 

$port = $qpst->GetSelectedPort(); 
  - or - 
$port = $qpst->GetPort("COM1"); 
if (defined $port) 
{ 
} 

9.6.1  EFS 19 

The EFS interface returns a pointer to the phone’s embedded file system interface. See Chapter 0 
for more information on this interface. 

NOTE: The EFS interface only works with phones that support the EFS 2.0 protocol. 22 

$efs = $port->EFS; 
if (defined $efs) 
{ 
} 

9.6.2  SoftwareDownload 27 

This method returns a pointer to the Software Download interface. See Chapter 0 for more 
information on this interface. 

 

$software_download = $port->SoftwareDownload; 
if (defined $software_download) 
{ 

} 
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9.6.3  Provisioning 1 

This method returns a pointer to the phone provisioning interface. See Section 9.10 for more 
information. 
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$provisioning = $port->Provisioning; 
if (defined $provisioning) 
{ 
} 

9.6.4  Reset() 9 

Reset sends a reset command to the phone. 
 

$port->Reset(); 

9.6.5  Offline() 13 

Offline sends a command to the phone to change it to offline mode. Use Reset to restart the phone 
and return it to online status. 

 

$port->Offline(); 

9.6.6  SendSPC(spc) 18 

This method sends the Service Provisioning unlock code. “spc” is a six-digit character string. If 
you send an incorrect string, the phone will disconnect from QPST for 1 min. 

 

$port->SendSPC(“123456”); 

9.6.7  SendCommand(cmd, tmo) 23 

This method sends an arbitrary command “cmd” to the phone and gets a response. It uses a 
command timeout value of “tmo” ms. 

For example, to send a 1-byte command ($command) and get a reply ($reply): 
 

$timeout_in_ms = 2000; 
$diag_cmd = pack "C", $command; 
 
$diag_request_var = Variant(VT_ARRAY | VT_UI1, length $diag_cmd); 
$diag_request_var->Put($diag_cmd); 
 
$reply = $port->SendCommand($diag_request_var, $timeout_in_ms); 
 
if (defined $reply) 
 
  # use the unpack command to turn $reply into an list of 
  # fields using $unpack_mask 
  @reply_values = unpack $unpack_mask, $diag_reply; 
} 
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9.6.8  LockPhone() 1 

This method sets the QPST state of the phone to locked to block cooperating QPST GUI 
applications from using this phone. 
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$port->LockPhone(); 

9.6.9  UnlockPhone() 6 

This method unlocks a phone locked previously with LockPhone. 
 

$port->UnlockPhone(); 

9.6.10  Phone information functions 10 

These functions return the same information as the Port List interface: 
 

PortName    PortLabel 

IsUSB    PhoneMode 

PhoneStatus   ModelNumber 

BuildId    ESN 

IMEI    MEID 

9.7  The COM Port List interface 18 

This interface enables you to examine all system COM ports. You can determine the port type 
(USB/Serial) and whether you have the port assigned to QPST. 

 

$port_list = $qpst->GetCOMPortList(); 

if (defined $port_list) 

{ 

} 

9.7.1  PortCount 26 

This method returns the number of COM ports. 
 

$port_count = $port_list->PortCount; 

NOTE: For the rest of the functions in this section, 0 <= $i < $port_count. 30 

9.7.2  PortName($i) 31 

This method returns the name of the COM port. 
 

$port_name = $port_list->PortName($i); 
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9.7.3  PortType($i) 1 

This method returns the port type as a string: 2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 

15 

16 

17 

19 

20 

21 

 Serial – Conventional UART serial port 

 USB/Unknown – Unknown type USB COM port, or non-Qualcomm device driver 

 USB/QC Data Modem – Qualcomm data modem 

 USB/QC Diagnostic – Qualcomm diagnostic port 

 USB/QC NMEA – Qualcomm gpsOne 

 Assigned – A disconnected USB phone, port still assigned to QPST 

 Waiting – A disconnected USB phone from a previous QPST session 

QPST works only with serial or USB/QC diagnostic port types. If a phone on a port of Assigned 
or Waiting type reconnects to the PC, QPST will begin to use it again. 

 

$port_type = $port_list->PortType($i); 

9.7.4  AssignedToQPST($i) 14 

This method returns nonzero if the port is in use by QPST, 0 if not. 
 

$port_asgn = $port_list->AssignedToQPST($i); 

9.7.5  DeviceDescription($i) 18 

This method returns a device description string from the USB device driver. 
 

$port_desc = $port_list->DeviceDescription($i); 
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9.8  Software Download interface 1 

Methods on this interface allow you to download a new software build to a phone. You must 
determine which method to use based on your knowledge of the target phone: 

2 
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 NAND vs. NOR Flash 

 Single-image vs multi-image download 

You must also know what setting to use for: 

 Trusted boot (secure boot) vs nontrusted boot 

 The Service Provisioning Code (SPC) 

To get a pointer to this interface, use the Port Proxy interface: 
 

$software_download = $port->SoftwareDownload; 

 

After a download operation completes, use GetErrorMessage to test the success of the operation: 
 

$error_message = $software_download->GetErrorMessage(); 

 

This will return an empty string if the operation succeeded; otherwise, it will return a description 
of the error. 

CAUTION: An unsuccessful software download will generally render the phone unusable. The only recovery 19 

is to reprogram the Flash device through the phone’s JTAG interface. 

NOTE: Before calling any of these methods, ensure the phone is ready and in Diagnostic mode (status 21 

equal 5 and phone mode 3 or 4). 

9.8.1  BackupNV 23 

This method backs up the phone’s NV data to a QCN file. 

→ $nv_backup_path = file path for a QCN-type file to save the NV contents for the new phone 
build, e.g., c:\download\backup.qcn 

→ $spc = the six-digit service provisioning code, e.g., 123456 
 

$software_download->BackupNV($nv_backup_path, $spc); 
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9.8.2  RestoreNV 1 

This method restores NV data to a phone from a QCN file. 2 

3 
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→ $nv_backup_path = file path for a QCN-type file to save the NV contents for the new phone 
build, e.g., c:\download\backup.qcn 

→ $spc = the service provisioning code, six-digit characters, e.g., 123456 

→ $allow_esn_mismatch = 0 to verify the ESN in the backup file matches phone, 1 to bypass this 
test; recommended setting is 0 
 

$software_download->RestoreNV($nv_backup_path, $spc, $allow_esn_mismatch); 

9.8.3  NANDFlash 10 

This method returns 0 for a NOR Flash, 1 for a NAND Flash. 
 

$nand_flash = $software_download->NANDFlash; 

9.8.4  DownloadPhoneImage 14 

This method downloads a new build to a single-image phone that uses NOR or NAND Flash. 

→ $phone_image_path = file path of the hex-format file to download, e.g., c:\download\build.hex 

→ $model_check_override = 0 to perform the model number check, 1 to bypass this test; 
recommended setting is 0 

→ $clear_phone_error_log = 0 to keep the current error log, 1 to clear the error log; 
recommended setting is 1. 

→ $nv_backup_path = file path for a QCN-type file to save the NV contents for the new phone 
build, e.g., c:\download\backup.qcn 

→ $spc = the six-digit service provisioning code, e.g., 123456 
 

$software_download->DownloadPhoneImage 

  ( 

    $phone_image_path, 

    $model_check_override, 

    $clear_phone_error_log, 

    $nv_backup_path, 

    $spc 

  ); 
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9.8.5  DownloadBootImage 1 

This method downloads a boot image to a single-image phone that uses NAND Flash. 2 
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→ $boot_image_path = file path of the hex file to download, e.g., c:\download\build.hex 

→ $spc = the six-digit service provisioning code, e.g., 123456 
 

$software_download->DownloadBootImage($boot_image_path, $spc); 

9.8.6  DownloadPhoneAndBootImage 7 

This method downloads both the boot image and phone image to a single-image NAND phone. 

→ $phone_image_path = file path of the hex file to download, e.g., c:\download\build.hex 

→ $boot_image_path = file path of the hex file to download, e.g., c:\download\build.hex 

→ $model_check_override = 0 to perform the model number check, 1 to bypass this test; 
recommended setting is 0 

→ $clear_phone_error_log = 0 to keep the current error log, 1 to clear the error log; 
recommended setting is 1 

→ $nv_backup_path = file path for a QCN-type file to save the NV contents for the new phone 
build, e.g., c:\download\backup.qcn 

→ $spc = the six-digit service provisioning code, e.g., 123456 
 

$software_download->DownloadPhoneAndBootImage 

  ( 

    $phone_image_path, 

    $boot_image_path, 

    $model_check_overide, 

    $clear_phone_error_log, 

    $nv_backup_path, 

    $spc 

  ); 

9.8.7  MultiImageDownload 28 

This method downloads a set of files to a phone that uses a multi-image configuration. 

→ $phone_image_path = a path to a directory that contains hex-format files to download. The 
path MUST end with a “\” character. The download files must use standard names: 

Required files 
partition.mbn pbl.mbn 

qcsbl.mbn qcsblhd_cfgdata.mbn 

oemsbl.mbn oemsblhd.mbn 

amss.mbn amsshd.mbn 
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Optional files 1 

2 
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apps.mbn and appshd.mbn 

appsboot.mbn and appsboothd.mbn 

NOTE: The pbl.mbn file is used only if $useTrustedMode is set to 0. 4 

→ $nv_backup_path = file path for a QCN-type file to save the NV contents for the new phone 
build, e.g., “c:\download\backup.qcn” 

→ $spc = the six-digit service provisioning code, e.g., 123456 

→ $overridePrtnTable = 0 to fail the download if partition.mbn doesn’t match the partition table 
in the phone, 1 to re-partition the phone’s flash. Repartitioning the flash device requires erasing 
the entire flash device. A failure after this point will render the phone unusable. You should only 
set this to 1 if GetErrorMessage() returned an error string indicating a partition table mismatch. 

→ $useTrustedMode = 0 to use non-trusted boot (requires pbl.mbn file), 1 to use trusted boot. 

→ $clear_phone_error_log = 0 to keep the current error log, 1 to clear the error log. 
Recommended setting is 1. 

→ $model_check_override = 0 to perform the model number check, 1 to bypass this test. 
Recommended setting is 0. 
 

$software_download->MultiImageDownload 

  ( 

    $phone_image_path, 

    $nv_backup_path, 

    $spc, 

    $overridePrtnTable, 

    $useTrustedMode, 

    $clear_phone_error_log, 

    $model_check_overide 

  ); 

9.8.8  DownloadCEFS_Image 28 

This method downloads a canonical EFS image that will replace the phone’s current EFS 
contents. You can extract a CEFS file from the phone using the QPST Gang Image application. 

→ $cefs_path = path to the CEFS file. 

→ $partition_path = path to the partition.mbn file. 
 

$software_download->DownloadCEFS_Image 

  ( 

     $cefs_path, 

     $partition_path 

  ); 
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9.9  EFS (phone file system) interface 1 

This interface allows you to modify the contents of the phone’s file system. 2 
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NOTE: The EFS interface only works with phones that support the EFS 2.0 protocol. 3 

You can get the EFS interface from the Port Proxy interface: 
 

$efs = $port->EFS; 

if (defined $efs) 

{ 

} 

NOTE: The phone protects some of its file system directories. You will receive an error if you try to 10 

access one of these directories. 

9.9.1  EFSVersion 12 

This method returns the EFS protocol version used by the phone. The methods on the EFS 
interface only work with phones that support version 2 of the protocol. 

Example 
$version = $efs->EFSVersion; 

if ($version == 2) 

{ 

  # Add code here that calls methods through $efs. 

} 

else 

{ 

 print "Incompatible EFS version\n"; 

} 

9.9.2  EFSMaxName 25 

This method returns the MAX_NAME field from the EFS2_DIAG_QUERY command. 

Example 
$efs_max_name = $efs->EFSMaxName; 

print "max name $efs_max_name\n"; 

9.9.3  EFSMaxPath 30 

This method returns the MAX_PATH field from the EFS2_DIAG_QUERY command. 

Example 
$efs_max_path = $efs->EFSMaxPath; 

print "max path $efs_max_path\n"; 
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9.9.4  EFSMaxLinkDepth 1 

This method returns the MAX_LINK_DEPTH field from the EFS2_DIAG_QUERY command. 2 
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Example 
$efs_max_link_depth = $efs->EFSMaxLinkDepth; 

print "max link depth $efs_max_link_depth\n"; 

9.9.5  EFSMaxFileSize 6 

This method returns the MAX_FILE_SIZE field from the EFS2_DIAG_QUERY command. 

Example 
$efs_max_file_size = $efs->EFSMaxFileSize; 

print "max file size $efs_max_file_size\n"; 

9.9.6  EFSMaxDirEntries 11 

This method returns the MAX_DIR_ENTRIES field from the EFS2_DIAG_QUERY command. 

Example 
$efs_max_dirs = $efs->EFSMaxDirEntries; 

print "max dirs $efs_max_dirs\n"; 

9.9.7  EFSMaxMounts 16 

This method returns the MAX_MOUNTS field from the EFS2_DIAG_QUERY command. 

Example 
$efs_max_mnts = $efs->EFSMaxMounts; 

print "max mounts $efs_max_mnts\n"; 

9.9.8  CopyPCToPhone 21 

This method copies a file from the PC to EFS. 

Example 
$efs->CopyPCToPhone($efs_path, $pc_path); 

→ $efs_path = destination path, e.g., /tmp/test.txt 

→ $pc_path = source path, e.g., c:\doc\test.txt 

NOTE: This method uses SHCreateStreamOnFile to access the file on the PC. That function will return 27 

an error if it cannot parse the $pc_path or access the file. 
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9.9.9  CreateDirectoryAndWriteFile 1 

This method creates intermediate directories to the EFS file named in $efs_path, if necessary, 
then uses CopyPCToPhone to copy the file from $pc_path to $efs_path. 
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Example 
$efs->CreateDirectoryAndWriteFile($efs_path, $pc_path); 

9.9.10  CopyPhoneToPC 6 

This method copies a file from EFS to the PC. 

Example 
$efs->CopyPhoneToPC($efs_path, $pc_path); 

→ $efs_path = destination path, e.g., /tmp/test.txt 

→ $pc_path = source path, e.g., c:\doc\test.txt 

NOTE: This method uses SHCreateStreamOnFile to access the file on the PC. That function will return 12 

an error if it cannot parse the $pc_path or access the file. 

9.9.11  CopyFile 14 

This method copies a file from one point in the EFS file system to a different point. 

Example 
$efs->CopyFile($old_efs_path, $new_efs_path); 

→ $old_efs_path = path to the existing file, e.g., /tmp/test.txt 

→ $new_efs_path = destination, e.g., /doc/doc1.txt 

9.9.12  DirList 20 

This method returns an object that contains a list of files and properties. The method returns only 
the filename, not the complete path. 

Example 
$dir_iter = $efs->DirList($efs_path); 

→ $efs_path = path to directory, e.g., /tmp 

← $dir_iter = pointer to the IItDirContents interface on a directory iterator object. 



 Using the QPST Automation Server 

80-V1400-3 L 108 Qualcomm Confidential and Proprietary  
 MAY CONTAIN U.S. AND INTERNATIONAL EXPORT CONTROLLED INFORMATION  
  

9.9.12.1  Directory iterator object ($dir_iter) 1 

9.9.12.1.1  Count 2 

This method returns the count of files/directories/links/etc. in the object. 3 
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Example 
$count = $dir_iter->Count; 

NOTE: For the following examples under this heading, 0 <= $i < Count. 6 

9.9.12.1.2  EntryName 7 

This method returns the filename, not the complete path to the file. 

Example 
$name = $dir_iter->EntryName($i); 

print "name $name\n"; 

9.9.12.1.3  EntryType 12 

This method returns the file type. 

Example 
%file_type_list = qw ( 

    0 file 

    1 dir 

    2 link); 

$ftype = $file_type_list{$dir_iter->EntryType($i)}; 

print " type $ftype\n"; 

NOTE: You can enumerate the entire file system by using DirList on subdirectories (entry type 1). 21 

9.9.12.1.4  Mode 22 

This method returns the file mode as a string. 

Example 
$fmode = $dir_iter->Mode($i); 

print " mode $fmode\n"; 

The mode can contain any combination of file protections "S_IXOTH", "S_IWOTH", 
"S_IROTH", "S_IXGRP", "S_IWGRP", "S_IRGRP", "S_IXUSR", "S_IWUSR", "S_IRUSR", 
and one of file type "S_ISCHR", "S_ISDIR", "S_ISBLK", "S_ISREG", "S_ISLNK", "S_ISITM". 
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9.9.12.1.5  EntrySize 1 

This method returns the size of the entry in bytes. 2 
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Example 
$fsize = $dir_iter->EntrySize($i); 

print " size $fsize\n"; 

9.9.12.1.6  AccTime 6 

This method returns the last access time as a string. 

Example 
$atime = $dir_iter->AccTime($i); 

print " acc time $atime\n"; 

9.9.12.1.7  ModTime 11 

This method returns the modification time as a string. 

Example 
$mtime = $dir_iter->ModTime($i); 

print " mod time $mtime\n"; 

9.9.12.1.8  ChgTime 16 

This method returns the status change time. 

Example 
$ctime = $dir_iter->ChgTime($i); 

print " chg time $ctime\n"; 

9.9.13  RecursiveDirList 21 

This method returns the same kind of object as DirList, but recursively traverses the directory tree 
starting at $efs_path. 

Example 
$dir_iter = $efs->RecursiveDirList($efs_path); 
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9.9.14  StatFile 1 

This method returns file properties. Note that this method uses references to Variant data types. 2 
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Example 
$mode  = Variant(VT_BSTR | VT_BYREF, ""); 

$size  = Variant(VT_I4   | VT_BYREF, 0); 

$nlink = Variant(VT_I4   | VT_BYREF, 0); 

$atime = Variant(VT_BSTR | VT_BYREF, ""); 

$mtime = Variant(VT_BSTR | VT_BYREF, ""); 

$ctime = Variant(VT_BSTR | VT_BYREF, ""); 

$efs->StatFile($efs_path, $mode, $size, $nlink, $atime, $mtime, $ctime); 

→ $efs_path = path to file. 

← $nlink = number of links to the file 

← $mode, $size, $atime, $mtime, $ctime = as described in the directory iterator object section. 

9.9.15  StatLink 14 

This method returns file properties. Note that this method uses references to Variant data types. 

Example 
$mode  = Variant(VT_BSTR | VT_BYREF, 0); 

$atime = Variant(VT_BSTR | VT_BYREF, 0); 

$mtime = Variant(VT_BSTR | VT_BYREF, 0); 

$ctime = Variant(VT_BSTR | VT_BYREF, 0); 

$efs->StatLink($efs_path, $mode, $atime, $mtime, $ctime); 

→ $efs_path = path to file. 

← $mode, $atime, $mtime, $ctime = as described in the directory iterator object section. 

9.9.16  MkDir 24 

This method creates a new directory. 

Example 
$efs->MkDir($new_efs_path); 

→ $new_efs_path = directory path to create. 
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9.9.17  RmDir 1 

This method removes a directory, which must be empty. 2 
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Example 
$efs->RmDir($efs_path); 

→ $efs_path = directory to delete. 

9.9.18  ReadLink 6 

This method translates a link to the path it represents. 

Example 
$fs_name = Variant(VT_BSTR | VT_BYREF, ""); 

$efs->ReadLink($efs_path,  $fs_name); 

→ $efs_path = path to the link 

← $fs_name = translation of the link to an absolute path 

9.9.19  Rename 13 

This method renames a file. 

Example 
$efs->Rename($old_efs_path, $new_efs_path); 

→ $old_efs_path = path to existing file 

→ $new_efs_path = new name for file 
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9.9.20  StatFS 1 

This method returns file system parameters. 2 
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Example 
$fs_id       = Variant(VT_I4   | VT_BYREF, 0); 

$fs_type     = Variant(VT_BSTR | VT_BYREF, ""); 

$blk_size    = Variant(VT_I4   | VT_BYREF, 0); 

$tot_blks    = Variant(VT_I4   | VT_BYREF, 0); 

$avail_blks  = Variant(VT_I4   | VT_BYREF, 0); 

$free_blks   = Variant(VT_I4   | VT_BYREF, 0); 

$max_size    = Variant(VT_I4   | VT_BYREF, 0); 

$n_files     = Variant(VT_I4   | VT_BYREF, 0); 

$max_n_files = Variant(VT_I4   | VT_BYREF, 0); 

 

$efs->StatFS($efs_path,  $fs_id, 

             $fs_type,   $blk_size, 

             $tot_blks,  $avail_blks, 

             $free_blks, $max_size, 

             $n_files,   $max_n_files); 

 

→ $efs_path = path to file system, e.g., “/”, “/mmc1”, etc. 

The return parameters are described by the File System ICD (see [Q3]). 

9.9.21  CreateLink 22 

This method creates a link to a file. 

Example 
$efs->CreateLink($old_efs_path, $new_efs_path); 

→ $old_efs_path = existing file path 

→ $new_efs_path = path to new link 

9.9.22  Delete 28 

This method deletes a file or link. 

Example 
$efs->Delete($efs_path); 

→ $efs_path = path to file to delete 



 Using the QPST Automation Server 

80-V1400-3 L 113 Qualcomm Confidential and Proprietary  
 MAY CONTAIN U.S. AND INTERNATIONAL EXPORT CONTROLLED INFORMATION  
  

9.9.23  RemoveTree 1 

This method deletes a subdirectory tree including the named directory. 2 
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Example 
$efs->RemoveTree($efs_path, $allow_root_delete); 

→ $efs_path = path to sub-directory tree. 

→ $allow_root_delete = set to 1 to allow “/” as $efs_path. If set to 0, 
RemoveTree will return an error if the root directory is used for 
$efs_path. 

9.9.24  IsDirectoryEmpty 9 

This method returns a Boolean value indicating whether the directory is empty. 

Example 
$is_empty = $efs->IsDirectoryEmpty($efs_path); 

→ $efs_path = path to directory. 

← $is_empty = returns 1 if the directory is empty, otherwise 0. 

9.9.25  GetLastError 15 

This method returns extended error information, then clears this error information. It is valid only 
when Win32::OLE->LastError() + 0 (the HRESULT) returns nonzero. 

EFS commands sent to the phone return an errnum value to indicate command success or failure. 
An errnum of 0 indicates success. The code returned as the third parameter of GetLastError 
returns the errnum if the phone rejected the command. Error codes 1 through 512 represent phone 
errnum values 0 through 511. Error code 513 indicates an errnum > 511. 

Error codes > 513 represent QPST internally detected errors. EFS directories protected by the 
phone will return EFS_bad_cmd_response because the phone’s diagnostic interface rejects the 
command. 

The text returned in the first parameter is generally the name of the EFS command that failed. 

An HRESULT of 0x80042190 indicates QPST performed a normal error recovery. An 
HRESULT of 0x80042191 indicates an unexpected QPST error. 

Because QPST calls Microsoft functions that also return HRESULTs, you could receive an error 
relayed back to you from that function. 

Example 
$description = Variant(VT_BSTR | VT_BYREF, ""); 

$guid        = Variant(VT_BSTR | VT_BYREF, ""); 

$help_ctx    = Variant(VT_I4   | VT_BYREF,  0); 

$help_file   = Variant(VT_BSTR | VT_BYREF, ""); 

$prog_src    = Variant(VT_BSTR | VT_BYREF, ""); 

 

$efs->GetLastError($description, $guid, $help_ctx, $help_file, $prog_src); 
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my (%error_desc_list) = qw ( 1 

2 

3 

4 

5 

6 

7 

8 

9 

10 

11 

12 

13 

14 

15 

16 

17 

18 

19 

20 

21 

22 

23 

24 

25 

26 

27 

28 

29 

30 

31 

32 

33 

34 

35 

36 

37 

38 

    2 EPERM 

    3 ENOENT 

    7 EEXIST 

    10 EBADF 

    13 ENOMEM 

    14 EACCES 

    17 EBUSY 

    19 EXDEV 

    20 ENODEV 

    21 ENOTDIR 

    22 EISDIR 

    23 EINVAL 

    25 EMFILE 

    27 ETXTBSY 

    29 ENOSPC 

    30 ESPIPE 

    35 FS_ERANGE 

    37 ENAMETOOLONG 

    40 ENOTEMPTY 

    41 ELOOP 

    302 ENOCARD 

    303 EBADFMT 

    304 ENOTITM 

    513 EFS_invalid_status 

    514 EFS_invalid_bytes_read 

    515 EFS_fd_mismatch 

    516 EFS_path_too_long 

    525 EFS_cmd_resp_mismatch 

    528 EFS_wr_offset_mismatch 

    530 EFS_incompat_version 

    533 EFS_bad_cmd_response); 

 

$context_text = $error_desc_list{$help_ctx}; 

if (!defined $context_text) 

{ 

  $context_text = $help_ctx; 

} 
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9.10  Provisioning interface 1 

This interface allows you to change provisioning data in the phone, such as NV items and 
roaming lists. You must get a pointer to the provisioning interface from the Port Proxy interface: 
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$provisioning = $port->Provisioning; 

For NV items, you must know the item number, whether the item uses an index (NAM or other 
index), and whether the item is protected by the SPC. For the purposes of this interface, the NAM 
index is zero-based.  

You must set the phone offline before calling any function that writes an NV item or PRL. Some 
items are protected by the SPC. You will have to send this to the phone before you can access 
these items. 

NOTE: NV items are always 128 bytes long. 11 

9.10.1  GetNVItem(itemNumber) 12 

This method returns the contents of NV item “itemNumber”. 
 

$nv_item_data = $provisioning->GetNVItem($nv_item_number); 

if (defined $nv_item_data) 

{ 

  @nv_item_fields = unpack $nv_item_description, $nv_item_data; 

 

} 

9.10.2  SendNVItem(itemNumber, itemData) 21 

This method sets NV item “itemNumber” to value “itemData”. This works only when the phone 
is offline. The “itemData” variable is a Microsoft safearray. 

NOTE: To write an item protected by the SPC, you must unlock the phone by sending the SPC before 24 

writing the item. 

# Create 128-byte safearray to hold request 

# $nv_item_data contains NV item data created with ‘pack’. 

$nv_data_var = Variant(VT_ARRAY | VT_UI1, 128); 

$nv_data_var->Put($nv_item_data); 

# You must set the mobile offline to write NV items. 

$port->Offline(); 

# Some NV items require sending the SPC before writing the item. 

# You would do that here. 

# Write the NV item. 

$provisioning->SendNVItem($nv_item_number, $nv_data_var); 

# Write the next NV item… 
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9.10.3  GetPRL(namIndex, rlFilePath) 1 

This method creates a file on the PC named “rlFilePath” and saves the contents of the preferred 
roaming list from NAM “namIndex” in it. You can create and edit PRL files with the QPST PRL 
Editor. 
 

$provisioning->GetPRL($prl_nam_index, $prl_file_name); 

9.10.4  SendPRL (namIndex, rlFilePath) 7 

This method writes a new PRL from the PC file “rlFilePath” to NAM “namIndex”. 
 

$provisioning->SendPRL($prl_nam_index, $prl_file_name); 

9.10.5  GetNVItemIndexed(itemNumber, itemIndex) 11 

This method returns the contents of NV item “itemNumber” at index “itemIndex”. 
 

$nv_item_data = $provisioning->GetNVItemIndexed($nv_item_number, $nv_item_index); 

9.10.6  SendNVItemIndexed(itemNumber, itemIndex, itemData) 15 

Write NV item “itemNumber” to value “itemData” at index “itemIndex”. See SendNVItem for an 
example of how to create $nv_data_var. 
 

$provisioning->SendNVItemIndexed($item_number, $item_index, $nv_data_var); 
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